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Communications regulation information
The following information is provided in compliance with US FCC (Federal Communications
Commission) and Canadian DOC (Department of Communications) regulations.

FCC statement
This equipment has been tested and found to comply with the limits for a Class B digital device
in accordance with the specifications in Part 15 of FCC rules. See instructions if interference to
radio or television reception is suspected.  

Radio and television interference
The equipment described in this manual generates, uses, and can radiate radio-frequency
energy. If it is not installed and used properly—that is, in strict accordance with Apple’s
instructions—it may cause interference with radio and television reception.  

This equipment has been tested and found to comply with the limits for a Class B digital device
in accordance with the specifications in Part 15 of FCC rules. These specifications are designed
to provide reasonable protection against such interference in a residential installation. However,
there is no guarantee that interference will not occur in a particular installation.  

You can determine whether your computer system is causing interference by turning it off. If
the interference stops, it was probably caused by the computer or one of the peripheral devices.  

If your computer system does cause interference to radio or television reception, try to correct
the interference by using one or more of the following measures:  
m Turn the television or radio antenna until the interference stops.  
m Move the computer to one side or the other of the television or radio.  
m Move the computer farther away from the television or radio.  
m Plug the computer into an outlet that is on a different circuit from the television or radio.

(That is, make certain the computer and the television or radio are on circuits controlled by
different circuit breakers or fuses.)  

If necessary, consult an Apple-authorized service provider or Apple. See the service and support
information that came with your Apple product. Or, consult an experienced radio/television
technician for additional suggestions. You may find the following booklet helpful: Interference
Handbook (stock number 004-000-00493-1). This booklet, prepared by the Federal
Communications Commission, is available from the U.S. Government Printing Office,
Washington, DC 20402.  

IMPORTANT  Changes or modifications to this product not authorized by Apple Computer, Inc.,
could void the FCC Certification and negate your authority to operate the product.

This product was tested for FCC compliance under conditions that included the use of Apple
peripheral devices and Apple shielded cables and connectors between system components. It is
important that you use Apple peripheral devices and shielded cables and connectors between
system components to reduce the possibility of causing interference to radios, television sets,
and other electronic devices. You can obtain Apple peripheral devices and the proper shielded
cables and connectors through an Apple-authorized dealer. For non-Apple peripheral devices,
contact the manufacturer or dealer for assistance.  
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DOC statement
DOC Class B Compliance  This digital apparatus does not exceed the Class B limits for radio
noise emissions from digital apparatus as set out in the interference-causing equipment standard
entitled “Digital Apparatus,” ICES-003 of the Department of Communications.  

Observation des normes—Classe B  Cet appareil numérique respecte les limites de bruits
radioélectriques applicables aux appareils numériques de Classe B prescrites dans la norme 
sur le matériel brouilleur : “Appareils Numériques”, NMB-003 édictée par le ministre des
Communications.  

VCCI statement

Notify your telephone company
Some telephone companies require that you notify the local business office when you hook up a
modem to their lines. 

Information you need in the United States 
The Apple LaserWriter 16/600 PS Fax Card complies with Part 68 of the FCC rules. On this
card is a label that contains, among other information, the FCC registration number and ringer
equivalence number (REN). If requested, provide this information to your telephone company. 
m Ringer equivalence number (REN): The REN is useful to determine the quantity of devices

you may connect to your telephone lines and still have all those devices ring when your
telephone number is called. In most, but not all areas, the sum of the RENs of all devices
connected to one line should not exceed five (5.0). To be certain of the number of devices
you may connect to your line, as determined by the REN, you should contact your local
telephone company to determine the maximum REN for your calling area. 

m Telephone jack type: USOC, RJ-11

An FCC-compliant telephone cord and modular plug are provided with this equipment. This
equipment is designed to be connected to the telephone network or premises wiring using a
compatible modular jack that complies with Part 68 rules. See the installation instructions for
details.
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Telephone line problems
If your telephone doesn’t work, there may be a problem with your telephone line. Disconnect
the product to see if the problem goes away. If it doesn’t, report the problem either to your local
telephone company or to your company’s telecommunications people. 

If disconnecting the product eliminates the problem, the product itself may need service. See the
service and support information that came with your Apple product for instructions on how to
contact Apple or an Apple-authorized service provider for assistance. 

If you do not disconnect your modem when it is adversely affecting the telephone line, the
telephone company has the right to disconnect your service temporarily until you correct the
problem. The telephone company will notify you as soon as possible. Also, you will be
informed of your right to file a complaint with the FCC. 

The telephone company may make changes in its facilities, equipment, operations, or
procedures that could affect the operation of your equipment. If this happens, the telephone
company will provide advance notice in order for you to make the necessary modifications to
maintain uninterrupted service.  

The Apple LaserWriter 16/600 PS Fax Option will not work with party lines, cannot be
connected to a coin-operated telephone, and may not work with a private branch exchange
(PBX). 

Telephone Consumer Protection Act 
The Telephone Consumer Protection Act of 1991 makes it unlawful for any person to use a
computer or other electronic device to send any message via a telephone fax machine unless
such message clearly contains in a margin at the top or botton of each transmitted page or on the
first page of the transmission, the date and time it was sent and an identification of the business
or other identity, or other individual sending the message and the telephone number of the
sending machine of such business, entity, or individual.
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Information you need in Canada 
The Canadian Department of Communications (DOC) label identifies certified equipment. This
certification means that the equipment meets certain telecommunications network operational,
and safety requirements. The Department does not guarantee the equipment will operate to a
user’s satisfaction. 

Before installing this equipment, make sure that you are permitted to connect to the facilities of
the local telecommunications company. Be sure you use an acceptable method of connection to
install the equipment. In some cases, you may extend the company’s internal wiring for single-
line individual service by means of a certified telephone extension cord. Be aware, however,
that compliance with these conditions may not prevent degradation of service in some
situations. 

Repairs to certified equipment should be made by an authorized Canadian maintenance facility
designated by the supplier. Any equipment malfunctions or repairs or alterations that you make
to this equipment may cause the telecommunications company to request that you disconnect
the equipment. 

In Canada, contact Apple at: 
7495 Birchmount Road
Markham, Ontario
L3R 5G2
800-263-3394

Users should ensure for their own protection that the electrical ground connections of the power
utility, telephone lines, and internal metallic water pipe system, if present, are connected
together. This precaution may be particularly important in rural areas. 

WARNING  Users should not attempt to make such connections themselves, but should contact the
appropriate electric inspection authority or electrician.
m Load number: See the label on the card.

The load number (LN) assigned to each terminal device denotes the percentage of the total load
to be connected to the telephone loop that is used by the device, to prevent overloading. The
termination of a loop may consist of any combination of devices, subject only to the
requirement that the sum of the load numbers of all devices does not exceed 100.
m Telephone jack type: CA-11
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The LaserWriter 16/600 PS equipped with fax capability gives you the ability
to send and receive facsimiles (faxes) with fax machines and other printers
equipped with the fax card.

What the fax card can do

When equipped with the fax card, the LaserWriter 16/600 PS

m Sends documents to any CCITT (International Telephone and Telegraph
Consultative Committee) Group III-compatible fax machine or printer
from an Apple Macintosh or IBM PC or compatible computer

m Receives and prints fax transmissions at 200 dpi—the Group III
standard—from Group III-compatible fax machines

m Receives and prints fax transmissions at 600 dpi from other printers
equipped with PostScript fax capability

m Sends PostScript-language files to other printers that have PostScript fax
capability so that documents print at the resolution of the receiving printer

m Sends a fax to multiple destinations with one command

m Delays fax transmission up to 24 hours, so you can schedule faxes for
economy and convenience

m Enables all users on a network connected to the printer to send faxes and
to receive fax printouts at the printer

m Sends and receives documents at speeds up to 9600 bps

ix

About the LaserWriter 16/600 PS Fax Card



The power of PostScript fax

What is a PostScript fax and what are its advantages? Rather than being a
graphical image, a PostScript fax is a script that a receiving PostScript device
can interpret and act on. This means that a PostScript document can summon
numerous graphical and font capabilities unavailable to an ordinary fax. 
The biggest advantage is that because you’re sending the fax in a resolution-
independent format, fax quality is substantially better. A second advantage is
that because of the compactness of a script, sending a PostScript fax takes
less time, thereby lowering telephone costs.
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This chapter explains how to set up your LaserWriter 16/600 PS printer and
install the PostScript fax card. You can easily install the fax card yourself.
However, if you prefer, an Apple-authorized service provider can install it 
for you. Before installing your fax card and software, be sure to take a look at
the Read Me file on the Macintosh Fax Printer Disk 1. It contains late-breaking
information that is not in this book.

1
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Do you have what you need?

To send and receive faxes with your LaserWriter 16/600 PS printer, you need
the following:

m The fax card

m An Apple Macintosh computer using system software version 7.0 or later

or

An IBM PC or compatible computer using DOS 3.3 or later with at least
640K of memory, or using Microsoft Windows 3.1 or 3.11 with at least 
1 MB of memory (4 MB or more recommended)

m For Macintosh users, the two Macintosh Fax Printer disks

m For DOS or Windows users, the Windows and DOS Fax Printer disk

m An anti-electrostatic or grounding wrist strap (supplied with the fax card)

m A wall phone jack that accepts an ordinary RJ-11 or CA-11 telephone cord.
The fax card won’t work if it’s connected to a digital phone line, designed
to carry computer data exclusively. It may not work if it’s connected to a
digital private exchange (PBX) system.

m A telephone cord for connecting the printer to the phone jack (supplied
with the fax option)

m A Phillips screwdriver

Important safety information

Follow these safety guidelines to protect yourself and your equipment:

m Never install telephone wiring during a lightning storm

m Never install telephone jacks in wet locations unless the jack is specifically
designed for wet locations

m Never touch uninsulated telephone wires or terminals unless the telephone
line has been disconnected at the network interface

m Use caution when installing or modifying telephone lines
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Installing the fax card

Installing the card involves opening the LaserWriter 16/600 PS printer,
installing the fax card, closing the printer, and connecting the printer to a
phone outlet. Be sure to wear the grounding wrist strap when working with
the card. Follow these steps.

1 If necessary, turn the printer so that the back cover (opposite the side with the Apple
logo and printer’s name) is accessible.

2 Open the top cover all the way.

Back cover

Phillips
screw

Top cover (opened)

WARNING  Make sure the printer is turned off.
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3 Locate the Phillips screw on the top of the printer (near the green cleaning brush). The
screw secures the back cover to the printer.

4 Unscrew and remove the screw. Put it in a safe place.

5 To minimize the toner cartridge’s exposure to light, close the printer’s top cover. 

6 Place your left hand on the left edge of the back cover and grasp the lower-right corner
with your right hand. Push the cover toward the right, pulling the cover’s right side away
from the printer. The back cover should slip out and away.

Push the cover
to the right, then
pull it away.
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IMPORTANT  Be sure to put on the grounding wrist strap before handling the
fax modem card or any internal printer parts. The strap grounds you to the
printer, preventing any static discharge that might harm the card or printer.
Wearing the strap cannot harm you. Follow these steps.

1 Wrap the end of the strap that does not have copper foil on it around your wrist. The
strap’s light adhesive coating keeps it attached to your wrist, while allowing for easy
removal.

2 Remove the backing from the piece of copper foil at the other end of the strap.

3 Attach the copper-foil end of the strap to the metal lip on the inside of the printer by
pressing the adhesive backing against the metal.

Copper-foil end Metal lip
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To install the fax card, follow these steps.

1 Find the connector opening marked “Fax” to the right of the back side of the printer.
Remove the plastic plug from the inside of the connector opening.

2 Hold the fax card with the component side toward the printer’s circuit board and slide its
lower-right corner under the grounding tab, while matching the fax card connector and
circuit board connector.

3 After seating the card, make sure that the phone line connector protrudes from the
connector opening marked “Fax.”

Squeeze the tabs
together to release

the plastic plug.
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4 Press firmly but gently on the left end of the card, so that the fax card connector and
printer circuit board connector fully engage. The post should snap into the hole on the
printer circuit board.

5 Secure the card to the grounding tab by tightening the supplied Phillips screw.

6 Detach the strap from the printer and from your wrist.

Slide the fax
card under the
grounding tab.

Grounding screw

Snap the post
into the hole.

Insert the fax card
connector into the 
circuit board connector.
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To replace the cover on the printer, follow these steps.

1 Line up the three tabs on the left edge of the back cover with the holes in the printer.
Gently press the cover into the printer.

2 Locate the stubby post in the lower-right corner of the back cover. Align the stubby post
in the cover with its receiving hole in the printer. Slide the cover to the left to guide the
post and hole together with your right hand, while pushing in on the lower middle of the
cover with your left hand. This action inserts the tab in the middle of the cover’s lower
edge into its receiving slot. The cover should slide into place.

To check the position of the back cover, open the top cover and look at the
Phillips screw hole on the top of the printer. The hole should be
unobstructed. (You shouldn’t replace the vertical Phillips screw unless the
back cover is properly positioned.)

If the hole is obstructed, examine the edge of the back cover to see where it’s
improperly positioned. Is the cover too high? Is the bottom-center edge
bulging? Wiggle the lower-right corner post into the hole while pressing
gently on the cover. If you still don’t get the cover to fit correctly, remove it
and try again. It may take a few tries.

3 With the back cover properly positioned, replace the Phillips screw. Do not 
overtighten it.

4 Close the top cover.

Cover tab Printer slot

Slip the three
tabs on the
back cover into
the holes in
the printer.

Stubby post

Receiving hole
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Connecting the fax printer to a phone line

To connect your LaserWriter 16/600 PS printer to the phone line, follow these
steps.

1 Connect one end of the telephone cable to the connector labeled “Fax” on the back of
the printer and the other end to the phone jack on the wall.

2 Turn on the printer. 

It’ll take a few moments to print the startup page. Notice that the startup page
shows a new icon and a new name for the printer: LaserWriter 16/600 PS Fax.
This is the name that will appear in the Chooser, even if you previously
named the printer.

3 If the printer software is not already installed, do it now.

For instructions, see your user’s guide, Apple LaserWriter 16/600 PS Setting Up,
Connecting, and Using Your Printer.

4 If the fax software is not already installed, install it now.

Macintosh users should see Chapter 2 in this book. DOS and Windows users
should follow Chapter 4.
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This chapter explains how to 

m Install the fax software on a Macintosh computer

m Set up the fax software

m Select settings for incoming faxes

m Set the date and time 

IMPORTANT  Before you install the fax software, you need to install the
LaserWriter 16/600 PS software that came with your printer and print a
document to verify that the software is installed properly. Follow the
instructions in the user’s guide for the LaserWriter 16/600 PS.

2 Installing the Fax Software on a 
Macintosh Computer



Installing the fax software

The Installer program included on the Macintosh Fax Printer disks installs the
LaserWriter Fax Utility program, the Fax Log utility, and the LaserWriter 8f
printer driver. The LaserWriter 8f driver provides sophisticated fax capability
along with the same features as the LaserWriter 8 driver that comes with the
LaserWriter 16/600 PS printer. To save disk space, delete your old LaserWriter
8 driver after installing the new driver.

Follow these steps to install the fax software.

1 Insert the Macintosh Fax Printer Disk 1.

2 Double-click the Installer icon.

3 Click OK in the Installer’s Welcome box.

The Easy Install dialog box appears.
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4 Verify that the disk named is the disk you want to install software on; then click Install.

A status bar shows the progress of the installation. When installation is
complete, follow the instructions on the screen.

The Installer places the following files and folders on your hard disk:

m The LaserWriter 8f driver, located in the Extensions folder (inside the
System Folder)

m The LaserWriter Fax Software folder, located in the System Folder

m The LaserWriter Fax Utility program, located in the LaserWriter Fax
Software folder

m The Fax Log utility, located in the LaserWriter Fax Software folder

m Alternate Cover Page.PS, a PostScript file you can use as a cover page (or
modify if you are familiar with PostScript programming), located in the
LaserWriter Fax Software folder

m Alternate Caption.PS, a PostScript file you can use to create a custom
caption on pages you fax (if you are familiar with PostScript
programming), located in the LaserWriter Fax Software folder

m LaserWriter 16/600 PS Fax (the default name for a printer with the fax
option installed), a PostScript Printer Description (PPD) file located in the
Printer Descriptions folder in the Extensions folder (inside the System
Folder)
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Setting up the fax software

Follow these steps to set up the fax software.

1 Be sure the LaserWriter 16/600 PS printer is on.

The following steps work only if the printer is on.

2 Choose the Chooser from the Apple (K) menu.

The Chooser appears.

3 Click the LaserWriter 8f icon (in the left half of the window).

If you don’t see the LaserWriter 8f icon, scroll the window. 

Note:  At this point, your printer has the default name, LaserWriter 16/600 PS
Fax, even if you previously named it something else. If there’s already a
printer named LaserWriter 16/600 PS Fax, the software will append a number
to the end of the name. If you want to give the printer another name, you must
rename it, using the Apple Printer Utility software that came with the printer.

The name of your fax printer appears in the right half of the window (along
with the names of other available LaserWriter printers).
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4 Click the name of your printer.

5 If you plan to send a fax to multiple destinations or if you plan to print copies of faxes
you send, make sure Background Printing is on.

6 Click Setup.

7 Click OK.

8 Close the Chooser.

Selecting incoming fax settings

You can select options for incoming faxes, such as the number of rings before
answering, using the LaserWriter Fax Utility. If you’ve come to this section
without having done the the tasks in the previous section, make sure you’ve
selected the LaserWriter 16/600 PS printer you want to use in the Chooser.

1 Find the LaserWriter Fax Utility inside the LaserWriter Fax Software folder that resides in
the System Folder.

2 Double-click the LaserWriter Fax Utility.

3 Choose Incoming Fax Settings from the Configuration menu.

After a moment, the Fax Configuration dialog box appears.
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4 In the Rings Before Answering box, type the number of rings after which the printer
should answer an incoming call.

5 In the Fax Machine ID box, type up to 20 characters that your printer will send to other
fax machines upon connection. For example, you could enter your company name or fax
number.

The printer always sends an identifier, whether sending or receiving a fax. 
If you leave this blank, the printer may send its name or the phone number it
is using. 

6 If you want to receive PostScript faxes only from people who know your password, type
the password you want to use in the Fax PostScript Password box.

If you use a password, be sure to inform the people who send you PostScript
faxes.

7 If you want the printer to generate a list of faxes it sent and received after approximately
20 faxes, click the “Automatic printing of activity report” checkbox.

8 Turn the speaker on your fax printer on or off by clicking On or Off.

When the speaker is on, you can hear modem sounds, such as dialing,
ringing, and connection. 

9 Click OK to save the settings.
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Setting the date and time

The fax printer stores the time and date, including it on activity reports, cover
pages, and page captions (see “Selecting Transmission Options” in Chapter 3).

To set the time and date, follow these steps.

1 Find the LaserWriter Fax Utility inside the LaserWriter Fax Software folder that resides in
the System Folder.

2 Double-click the LaserWriter Fax Utility.

3 Choose Fax Printer Calendar from the Configuration menu.

The Fax Printer Calendar dialog box appears.

4 Set the current date and time.

To use the current date and time stored on your Macintosh computer, click
the Current Time button. To use a different time, type the new values in the
boxes. Enter the hour in 24-hour format, where 0 means 12:00 midnight and
13 means 1:00 PM.

5 Click OK.
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3 Using the Fax Software on a
Macintosh Computer

This chapter explains how to send faxes from a Macintosh computer. It
contains instructions for

m Selecting transmission options

m Creating and maintaining a fax phone book

m Sending and printing a fax

m Printing activity reports

m Using the LaserWriter Fax Log utility

m Receiving a fax



Selecting transmission options

Fax transmission options specify how the software dials the receiving fax
machine. To set options, you must open the Fax Destinations dialog box.
Follow these steps.

1 Choose Print from your application program’s File menu or, from the Finder, choose
Print Window from the File menu.

The LaserWriter Print dialog box appears.

2 In the Destination section, click Fax.

After you click Fax, the Print button becomes the Fax button.

3 To select fax transmission options, click Options in the Fax Destinations dialog box. The
Fax Options dialog box appears.
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Selecting dialing options

Follow these steps to select dialing options.

1 If your phone system requires that you dial a number or wait to get an outside line, type
one or more of the following characters in the Outside Line Prefix box.

To do this Type this

Dial this number before dialing the fax number 0–9

Press this key before dialing the fax number * or #

Wait for a dial tone W

Pause for two seconds ,

For example, to dial 9 and then wait for a dial tone, type 9W.

You can override the outside line prefix for any fax transmission. It’s a good
idea to enter the outside line prefix you most often dial.

If you don’t need to dial a number to get an outside line, leave this blank. It
isn’t necessary to type a W or comma (,) in the first position because the fax
card always waits for a dial tone before dialing the first digit in a fax number.

2 Click Tone Dialing or Pulse Dialing.

3 If you must dial a prefix, such as 1, to call outside your area code, type it in the Long
Distance Prefix box.

4 To make the area code from which you are dialing the default for sending faxes, type the
area code in the Current Area Code box.

If you leave this blank, you need only type area codes for numbers outside
your area code.

Parentheses around the area code are optional. If you use parentheses here,
you must also use them in fax numbers you add to your fax phone book. (See
“Creating and Maintaining a Fax Phone Book,” later in this chapter.)
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5 In the “Maximum number of retries” box, type the maximum number of times—0 to 100—
the fax software should redial the fax number if it cannot connect.

Tip:  Set this to a low number such as 1 or 2. No more than two tries are
normally required. Large numbers of retries can tie up the printer with
continued redials.

6 In the “Minutes to wait before retrying” box, type the number of minutes—1 to 60—you
want the fax software to wait before redialing a number.

7 Click OK.

To send a fax, see the next section, “Sending a Fax to a Single Destination.”
To set other options, such as a cover page, continue with the next sections. 

Including a fax cover page

You can attach a fax cover page to the beginning of any fax transmission. The
cover page lets the recipient know who sent the fax and to whom it is
addressed.

To include a fax cover page:

m Make sure you are viewing the Fax Options dialog box. 

1 Click the Cover Page checkbox.

2 Choose a cover page file from the Cover Page pop-up menu.

m Choose “Use Printer’s Default” to include a cover page consisting of the
sender’s and receiver’s names, company names, and fax phone numbers. 

Note:  Default cover pages are permanently stored in the printer. The others
are PostScript files on the Macintosh.

m Choose “Use <filename>” to select the cover-page file that was selected
most recently. (This item is unavailable if you are installing the fax
software for the first time.)
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m Choose Change to select another PostScript file. When you installed the
fax software, an alternate cover page file named Alternate Cover Page.PS
was installed in the LaserWriter Fax Tools folder (in the System Folder).
Both cover-page files present the same information, but use different
formats. Experiment to see which file you prefer. You can modify Alternate
Cover Page.PS, if you are familiar with PostScript programming.

The fax software will continue to use the cover-page file you choose for
subsequent transmissions (when the Cover Page checkbox is selected), unless
you choose a different file.

Including a page caption

If you wish, you can include a heading, or caption, on every page you
transmit. For example, you may want to have your name, the date, and the
page number on every page.

To include a caption:

1 Make sure you are viewing the Fax Options dialog box. 

2 Click the Page Caption checkbox.

3 Choose a caption from the Caption pop-up menu.

IMPORTANT  Captions do not appear on PostScript language transmissions.

m Choose “Use Printer’s Default” to include a caption that includes the
sender’s name, receiver’s name, date, time, and page number. The sender’s
and receiver’s names are the names you type in the Cover Page dialog box
or the fax phone book.

m Choose “Use <filename>” to select the caption that was selected most
recently. This item is unavailable the first time you install the fax software.

m Choose Change to select a new caption. When you installed the fax
software, a caption file named Alternate Caption.PS was installed in the
LaserWriter Fax Software folder (in the System Folder). It contains the
same information as the default caption, but you can modify it if you are
familiar with PostScript programming.

23Using the Fax Sof tware on a Macintosh Computer



Printing a copy of a fax

Click the Local Copy checkbox in the Fax Options dialog box if you want a
copy of the fax you send to be printed on your LaserWriter 16/600 PS printer.
The fax software can print a copy only if Background Printing is turned on in
the Chooser.

Printing a confirmation page

If you want the fax printer to print a confirmation page after each
transmission, click the Confirmation Pages checkbox in the Fax Options
dialog box. The page includes 

m The time the fax was transmitted

m The number of pages it contained

m The duration of the transmission

m The destination fax number

m Other status information

Selecting the resolution

The LaserWriter 16/600 PS can transmit faxes at two Group III resolutions. 
In the Fax Options dialog box:

m Click Standard to transmit at 203 horizontal by 98 vertical dots per inch.

m Click Fine to transmit at 203 horizontal by 196 vertical dots per inch.

If you are sending to a printer equipped with PostScript fax capability, you
can send and receive faxes at a higher resolution. Just transmit the fax as a
PostScript-language file, as described in the next section.
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Sending a PostScript fax

When you send a fax to a printer equipped with PostScript capability, you
have the option of sending a PostScript fax instead of standard CCITT Group
III data. The PostScript fax prints at the resolution of the receiving printer,
typically 300 dots per inch or greater.

There are two benefits in sending PostScript-language files. First, the fax
quality is substantially better, because the fax is printed at the receiving
printer’s resolution, on plain paper. Second, transmission time is usually
shorter, resulting in lower telephone line charges.

To send a PostScript fax, click the PostScript checkbox in the Fax Options
dialog box.

Follow these guidelines when you transmit PostScript-language faxes.

m You can send PostScript-language faxes only to printers equipped with
PostScript fax capability.

m If the recipient has a fax password, you must provide the fax password
when you transmit or else the transmission will fail.

m If the PostScript-language fax transmission fails, the printer automatically
hangs up, re-dials, and re-sends the fax in Group III format. This ensures
that the document is transmitted.

m For shorter transmission time, compress the file by selecting Compressed
in the Fax Options dialog box. 

If necessary, fonts are transmitted along with PostScript faxes to the receiving
printer. The sending printer uses its own list of resident fonts to determine
which ones need to be transmitted. If you have used the Apple Printer Utility
to download additional fonts to your printer, it will assume that other printers
have access to the same fonts and will not transmit these fonts along with a
PostScript fax. In this case, the receiving printer will substitute the Courier
font, possibly changing the formatting of the document. To prevent this from
occurring, follow two guidelines. 

First, use only the 35 standard printer-resident fonts. This avoids the need to
transmit any fonts and reduces the transmission time for PostScript faxes.
Second, use fonts that have not been previously downloaded to the printer
with the Apple Printer Utility. This ensures that the fonts will be transmitted
to the receiving printer.
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Creating and maintaining a fax phone book

To save time typing recipients’ names and fax numbers, you can create a fax
phone book that contains frequently used numbers. When you prepare to
transmit, select the recipients’ names from the list; the software automatically
inserts their fax numbers into the appropriate fields.

You can add individuals and groups to your fax phone book. A group is two
or more individuals to whom you want to broadcast the same document.

You add an individual to your fax phone book using the Fax Phone Book
Editor. You can open the Editor in any of several ways:

m In the Fax Cover Page dialog box, click Add to Phone Book.

m Double-click the LaserWriter Fax Utility icon. Then choose Fax Phone
Book from the Configuration menu.

m In the Fax Destinations dialog box, click Phone Book. This is the most
common way to access the Phone Book.

Here’s how to get to the Phone Book by way of the Fax Destinations dialog
box. Follow these steps.

1 Choose Print from your application program’s File menu.

The LaserWriter Print dialog box appears.

2 In the Destination section, click Fax.

After you click Fax, the Print button becomes the Fax button.

By the way:  Certain programs, such as Aldus PageMaker (version 4.2 and
earlier) and QuarkXPress, use a printer driver other than Apple’s. If you don’t
see the Fax button, click Cancel, and then choose Print again while holding
down the Option key. If the Fax button still does not appear, refer to your
program’s user manual for instructions on using the LaserWriter 8 driver.
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3 Select other printing options as you would ordinarily.

4 Click the Fax button.

The Fax Destinations dialog box appears.

5 Click Phone Book.

The Fax Phone Book Editor Dialog box appears.
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Adding individuals

To add an individual entry to the fax phone book, follow these steps.

1 Click the Add button at the bottom of the dialog box.

The Fax Phone Book Entry Editor dialog box appears.

2 Type the name, company, and fax number.

Be sure to use the same format for the fax number for every entry. For
example, if you use parentheses around the area code, put them around every
area code. 

Note:  If you’re faxing from your own area code, be sure to set this as one of
your options.
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3 If the receiving fax supports PostScript, click the Can Receive PostScript checkbox.
Then type the password, if you need to use one.

You can get the password from the recipient.

4 Click Add.

The new entry now appears in the fax phone book.
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Adding groups

A group can consist of individuals and other groups. For example, you might
create a Marketing group, an Engineering group, and a Documentation group,
and then create a group that contains all three.

To add a group to the fax phone book, follow these steps.

1 Add each individual member of the group to the fax phone book.

For instructions, see the previous section, “Adding Individuals.”

2 Hold down the Shift key as you click the individuals or groups you want to include.

3 Click Save As Group.

The Fax Group Editor dialog box appears.

4 Type the group name.

5 Click Add.

The group name now appears in the fax phone book. 

The following fax phone book includes two groups, both containing two or
more individuals in the list.
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Importing phone book entries

You can create phone book entries in any application program that can create
text (ASCII) files. Type the name, company name, fax number, and Y or N for
the PostScript (Y/N)? item, separating each with a tab character and adding
one tab character at the end of the line (before pressing the Return key). If
you don’t include the tab before the carriage return, you will get a file-format
error message when you try to import the file.

IMPORTANT  The PostScript (Y/N) field must be a capital Y or N.

By the way:  You can leave an item blank, but be sure that this blank field has
a tab character on either side.

The lines below show how to place tab characters.

Note: The symbol “<tab>” stands for one tab character, and “<cr>” is a
carriage return. See the example below. In the first line, all four fields are
present. In the second and third lines, some fields are missing. 

Donald Terry<tab>ACME, Inc.<tab>804-555-9876<tab>Y<tab><cr>

Ann Smith<tab><tab>417-555-9112<tab>N<cr>

<tab>STEAM POWER CO.<tab>409-555-2431<tab>N<tab><cr>

As a general rule, don’t exceed 100 entries in a phone book file. If you need
more than this, see the suggestions in the “Troubleshooting” chapter near the
end of the book.

Follow these steps to import a text file containing a phone book entry.

1 Display the Fax Phone Book Editor dialog box.

2 Click the Import button.

A file-selection dialog box appears.

3 Select the file you want to import; then click the Open button.

The entries appear in your fax phone book.
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Exporting phone book entries

You can exchange phone book entries with other people by exporting entries
into a file that other people can import.

1 Display the Fax Phone Book Editor dialog box.

2 Click Export.

A dialog box appears. 

3 Decide where you want to save the file, and type a name for the file.

4 Click Save. 

This saves a file containing the fax phone book. You can import and use it 
on any Macintosh that is running the fax option software. You can view the
contents of the exported phone book file with TeachText, SimpleText, or a
word processor.

Sorting phone book entries

To sort entries by individuals’ last names or company names, click the Sort by
Name or Sort by Company button.

Editing phone book entries

You should edit entries in your fax phone book when a name, phone number,
or company name changes. You can also edit an entry and save it under a new
name. For example, if you want to add a person who works at the same
company and has the same fax number as another person, you can edit the
existing entry instead of typing a completely new entry. 

To edit a fax phone book entry, follow these steps.

1 Click the individual or group you want to edit.

2 Click Edit.

3 Type the new information.

4 Click Replace to replace the original entry with the edited entry, or click Add to save the
edited entry as well as the original entry.
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Sending a fax

This section gives step-by-step instructions for sending a fax to an individual
destination or multiple destinations. It also shows you how to set the time for
sending a fax.

Sending a fax to a single destination

To send a fax to a single destination, follow these steps.

1 Choose Print from your application program’s File menu.

The LaserWriter Print dialog box appears.

2 In the Destination section, click Fax.

After you click Fax, the Print button becomes the Fax button.

By the way:  Certain programs, such as Aldus PageMaker (version 4.2 and
earlier) and QuarkXPress, use a printer driver other than Apple’s. If you don’t
see the Fax button, click Cancel, and then choose Print again while holding
down the Option key. If the Fax button still does not appear, refer to your
program’s user manual for instructions on using the LaserWriter 8 driver.

3 Select other printing options as you would ordinarily.
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4 Click the Fax button.

The Fax Destinations dialog box appears.

If you have added entries to the fax phone book, they appear in the large
panel. (See “Creating and Maintaining a Fax Phone Book,” earlier in this
chapter.)

The first time you send a fax, you must specify how the software connects to
the receiving fax machine. If you have not done this, see the earlier section,
“Selecting Transmission Options.” When you’ve finished setting the options,
return to this section and continue with step 5.

5 Specify the phone number.

Either type the fax phone number in the Fax Number box, or click the desired
name.

If you specified an outside line prefix in the Fax Options dialog box (such 
as 9), it already appears in the Fax Number box. (To override the number in
the box, type over it.)

You can click groups or individuals from the list or shift-click several entries
to create a group “on the fly.”



6 Click the Fax or Send Fax button.

The Print button changes to “Fax” if you’ve selected a cover page. If you
haven’t, it reads “Send Fax.”

If you did not select the Cover Page option, the fax software begins sending
the fax. Depending on which options you have selected, you’ll hear and see
different things. For example, if the speaker is on, you’ll hear the modem dial.
If you selected Local copy, the printer will print a copy of your fax.

If you’ve selected Cover Page, the Fax Cover Page dialog box appears.

If you selected the recipient from the fax phone book, the recipient’s name,
company, and fax number appear in the Name, Company, and Fax Number
boxes.

If you selected a group from the fax phone book, each recipient’s name,
company, and fax number will appear on the recipient’s cover page.

7 Fill out the Fax Cover Page dialog box. 

To add the address you’ve typed to your fax phone book, click Add to Phone
Book; then click OK.

8 Click Fax to begin sending the cover page and the fax.

If you selected a group from the fax phone book, each recipient’s name,
company, and fax number will appear on the recipient’s cover page.
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Sending a fax to multiple destinations

You can “broadcast,” or send a fax to multiple recipients with a single
command.

Decide whether you want the LaserWriter 16/600 PS printer or your
Macintosh computer to manage the broadcast. 

m If you select the printer, your computer sends a single copy of the file to
the fax printer, which then sends a copy to each recipient. There are two
advantages to using the printer as the broadcast device. First, the printer
can transmit the fax, even if the computer is turned off. Second, it’s easier
to delay transmission (see the section “Delaying Transmission”). However,
the job of reproducing multiple faxes can consume so much printer
memory that no memory is left to handle other jobs.

m If you select the computer, the Macintosh makes one copy of the file for
each recipient. Each copy becomes a separate job in the print queue. Use
the computer if you plan to use your LaserWriter 16/1600 PS printer for
printing during the fax broadcast.

Note:  If you want to send a single fax to multiple recipients in the two
different formats—PostScript and Group III printers—you must send through
the computer, not through the printer.

When you create a mixed group, you get an alert when you broadcast using
the printer instead of the computer. The alert states: “When sending a single
job to a group with mixed PostScript and Group 3 fax capabilities, Broadcast
Using Computer must be selected.”

Note:  If you plan to use the computer (not the printer) to manage the
broadcast, make sure that Background Printing is turned on.

If you plan to use the printer to manage the broadcast, Background Printing
can be on or off.
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Follow these steps to broadcast a fax to multiple locations.

1 Choose Print from your application program’s File menu.

The LaserWriter Print dialog box appears.

2 In the Destination section, click Fax.

After you click Fax, the Print button becomes the Fax button.

By the way:  Certain programs, such as Aldus PageMaker (version 4.2 and
earlier) and QuarkXPress, use a printer driver other than Apple’s. If you don’t
see the Fax button, click Cancel, and then choose Print again while holding
down the Option key. If the Fax button still does not appear, refer to your
program’s user manual for instructions on using the LaserWriter 8 driver.

3 Select other printing options as you would ordinarily.

4 Click the Fax button.

The Fax Destinations dialog box appears.
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If you have added entries to the fax phone book, they appear in the large
panel. (See “Creating and Maintaining a Fax Phone Book,” earlier in this
chapter.)

The first time you send a fax, you must specify how the software connects to
the receiving fax machine. If you have not done this, see the earlier section,
“Selecting Transmission Options.” When you’ve finished setting the options,
return here and continue.

If you specified an outside line prefix in the Fax Options dialog box (such 
as 9), it already appears in the Fax Number box. (To override the number in
the box, type over it.)

5 Hold down the Shift key as you click the individuals and groups to which you want to
transmit the fax.

6 From the “Broadcast using” pop-up menu, choose a device to manage the transmission:
Printer or Computer.

7 Click Fax or Send Fax to begin the transmission.

If the Cover Page option is selected, the Fax Cover Page dialog box appears
before the transmission actually begins. See “Sending a Fax to a Single
Destination” earlier in this chapter.

Delaying transmission

If you don’t want to send a fax immediately, you can specify the time when
the printer begins transmission. For example, you might want to send a fax
after business hours to minimize the cost of telephone calls, or when you are
not using your printer for other tasks.
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To specify the time of transmission to a single recipient, or to a group if the
printer (not the computer) is the broadcast device, follow these steps.

1 Complete the Fax Destinations dialog box, as explained in the section “Sending a Fax to
a Single Destination” earlier in this chapter.

2 Click the “Send at” checkbox at the bottom of the dialog box; then enter the time when
you want transmission to begin.

3 Click Fax or Send Fax.

The printer will attempt transmission at the specified time.

To specify the time of transmission when the computer is the broadcast
device, follow these steps.

1 Open PrintMonitor.

If PrintMonitor does not appear in your Application menu, double-click its
icon, which is in the Extensions folder inside the System Folder.

2 Choose Stop Printing from the PrintMonitor File menu.

3 Open the document you want to fax. Then complete the Fax Destinations dialog box.

4 Choose Computer from the “Broadcast using” pop-up menu.

5 Click the Fax or Send Fax button.

6 Choose PrintMonitor from the Application menu. (It may take a few moments for the
PrintMonitor to appear.)

7 Click the documents waiting to be transmitted. Then click the Set Print Time button.

The Set Print Time dialog box appears.
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8 Type the time and date you want the computer to begin transmitting the fax.

The time must be within 24 hours of the current time.

9 Click OK.

10 Choose Resume Printing from the PrintMonitor File menu.

The Macintosh computer will attempt transmission at the appropriate time.
Note that the computer must be on until all jobs are sent to the printer. 

11 Close the PrintMonitor window.

Printing activity reports

Fax activity reports provide information about faxes transmitted from and
received by your printer. You can print the report or view it on screen.

By the way:  If you want the software to generate the report whenever the log
is full—after approximately 20 faxes—select “Automatic printing of activity
report” in the Fax Configuration dialog box (see “Selecting Incoming Fax
Settings” earlier in this chapter).

1 If the LaserWriter Fax Utility is not already open, double-click its icon.

The LaserWriter Fax Utility is located in the LaserWriter Fax Software Folder.

2 Choose Display Activity Report or Print Activity Report from the Configuration menu.

The report is displayed on your screen or printed on your fax printer.

3 Click OK.

4 To clear the activity report, choose Clear Activity Report from the Configuration menu.
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Using the LaserWriter Fax Log

The Fax Log program keeps a record of all the faxes you send from your
computer through any LaserWriter with fax capability. Each time you send a
fax, the Fax Log is updated with information about the recipient of the fax,
the printer used, and transmission status. With Fax Log, you can keep track of
faxes sent, or you can copy information from Fax Log to application
programs.

This section shows you how to 

m Use the Fax Log utility

m Display information in the Fax Log window

m Display all information about a fax

m Sort information in the Fax Log window

m Update fax status automatically

m Update fax status manually

m Remove log entries manually

m Remove log entries automatically

m Copy log entries to a program

Using Fax Log

To open Fax Log, double-click its icon, found in the LaserWriter Fax Software
folder inside the System Folder. 

To open the Fax Log window, choose Open Log from the File menu.

The Fax Log window can display numerous categories of information about
faxes sent from your computer. You can choose which categories to display,
and you can sort information based on these categories.

Each entry in the Fax Log window represents a fax sent from your computer.
An icon at the left of each entry shows the status of the fax.
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Displaying information in the Fax Log window

To choose which categories of information to display in the Fax Log window,
follow these steps.

1 Open a Fax Log window by choosing Open Log from the File menu.

2 From the File menu, choose Preferences.

The Preferences window opens.

3 In the Preferences window, click the box next to each category you want to display.

4 After making your choices, close the Preferences window.

The Fax Log window displays the categories you chose.

Displaying all information about a fax

You can display all of the information about a fax in the Fax Info window.
Follow these steps.

1 Open a Fax Log window by choosing Open Log from the File Menu.

2 In the Fax Log window, double-click the fax you want to know about.

The Fax Log Info window opens.

3 When you’ve finished reading, close the Fax Log Info window.

Sorting information in the Fax Log window

You can sort entries in the Fax Log window by any category displayed. To
sort, click the name of the category you want to sort by. You can also choose
the category to sort by from the View menu.
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Updating fax status automatically

The Fax Log window shows information about faxes in various stages of
completion. To have Fax Log automatically update information about faxes in
the list, follow these steps.

1 From the File menu, choose Preferences.

The Preferences window opens.

2 In the top area of the Preferences window, click the box next to “Auto update.”

3 Click to enable the box next to “hr” or “min” to set the interval between automatic
updates.

You can set hours from 0 to 24 and minutes from 0 to 59. 0 is midnight, and
13 is one o’clock in the afternoon. Important: Do not set updating to 0 hours
and 0 minutes.

Updating fax status manually

To update the status of a fax listed in the Fax Log window manually, follow
these steps.

1 Click to select the fax entry you want update.

2 From the File menu, choose Check Status.

Status information for the selected fax is updated.

Removing entries manually

To remove an entry from a Fax Log window, follow these steps.

1 Click to select the fax entry you want remove.

2 From the Edit menu, choose Clear.

The entry is deleted.
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Removing entries automatically

To have Fax Log automatically remove entries for completed faxes, follow
these steps.

1 From the File menu, choose Preferences.

The Preferences window opens.

2 In the Preferences window, click the box next to “Remove completed transmissions at
startup.”

When this setting is selected, Fax Log deletes all entries for completed
transmissions. The entries are deleted each time Fax Log starts. Note: If you
leave Fax Log open, completed transmissions are not removed from the log.

Copying log entries to an application program

To copy entries from the Fax Log window to other programs, follow these
steps.

1 Open a Fax Log window by choosing Open Log from the File menu.

2 Press Shift and click to select the entries you want to copy.

Alternatively, open the Edit menu, and choose either Select All or Select
Completed.

3 In the Preferences window, click the box next to each category you want to display.

You can cut or copy selected information from the Fax Log window using the
Edit menu commands Cut and Copy.

4 In your other program, open the Edit menu and choose Paste.

The Fax Log entries are pasted from the Clipboard into the open document in
your other program, Fax Log places a tab between each category of
information in the entry.
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Receiving faxes

To receive a fax, you need to have the printer turned on. The computer can be
off. A properly configured printer will print each fax when it comes to the top
of the print queue.

Printing legal-size documents

To print large documents, such as legal-size faxes, put legal-size paper in the
paper tray and install it. The fax option will print on what it finds there. If a
legal-size fax is received and no legal-size paper has been loaded into the
printer, each page of the fax will be reduced in size to fit on letter-size paper.
Fax pages will also be reduced in size if a letter-size fax is received that does
not have adequate top and bottom margins.
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This chapter explains how to install the fax software on IBM PC or
compatible computers. It covers these topics:

m Preparing to install the fax software

m Installing the fax software

m Installing the fax software on a network

m Installing the Fax Control Panel in Windows

m Enabling and disabling the automatic load option

m Setting advanced options

m Removing the fax software from Windows 

m Unloading the DOS fax software from memory

m Changing installation settings after you have run the Install program

The installation steps are the same for the MS-DOS and the Windows
environments, unless an instruction states otherwise.

IMPORTANT  Before you install the fax software, you need to install the
LaserWriter 16/600 PS software that came with your printer and print a
document to verify that the software is installed properly. Follow the
instructions in the user’s guide for the LaserWriter 16/600 PS.
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Preparing to install the fax software

Before installing the fax software:

m Identify the port to which your printer is connected—usually LPT1 or
LPT2.

m Make sure that you have at least 700K (approximately) of hard disk space
available for the fax software files.

m If you will be using the fax software to print from DOS applications,
determine if the Alt-F1 hot-key combination is used in any other software
you use. If so, you’ll need to select another hot-key combination for the fax
software.

IMPORTANT  If you are using a LaserWriter 16/600 PS connected to a network,
see “Installing the Fax Software on a Network,” later in this chapter, before
proceeding.

Installing the fax software

Follow these steps to install the fax software to run under the DOS or
Windows operating system.

1 Insert the Windows and DOS Fax Printer Disk into a disk drive.

The remaining instructions use drive A. If you prefer a different drive,
substitute its name for “A”.

2 If you are using Windows, choose the Run command in the Program Manager. Type the
following line into the Command Line box and press Enter.

A:\install

3 If you are using DOS, at the DOS prompt, type the following line and press Enter.

A:\install

The Install program displays a welcome message and lists the information
that you will need for installation. 
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4 Press Enter to continue.

The Hard Disk Drive Selection screen appears.

5 Press Enter to accept C as the destination hard drive, or type a different drive designator
and press Enter.

The Hard Disk Drive Directory Selection screen appears.

6 Press Enter to accept \PSFAX as the directory, or type a new directory name and 
press Enter.

The Confirmation Before File Copy screen appears.

7 If the drive and directory information is correct, press Enter.

If you need to change any of the information, press Esc until the screen
containing the information you want to change appears. Then press Enter
until the Confirmation Before File Copy screen appears again.

The Install program begins copying the fax software. 

8 When a message appears stating that the files have been copied, press Enter.

The Printer Port Selection screen appears.
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9 Use the arrow keys to select the port to which your printer is connected; then 
press Enter.

If your LaserWriter 16/600 PS is connected to a network, select the network
software’s capture port. The capture port is the port from which the fax
software will redirect data to a network print server.

After you press Enter, the User’s Fax Sender Information screen appears.

10 Type your name, the name of your company, your telephone number, and your fax
telephone number.

This information appears on the fax cover page. You may leave one or more
fields blank if you wish. 

The Telephone Settings screen appears. 



11 If your phone system requires that you dial a number or wait to get an outside line, type
one or more of the following characters in the Outside Line Prefix text box.

If you don’t need to dial a number to get an outside line, leave this blank.

To do this Type this

Dial this number before dialing the fax number 0–9

Press this key before dialing the fax number * or #

Wait for a dial tone W

Pause for two seconds ,

For example, to dial 9 and then wait for a dial tone, type 9W.

You can override the outside line prefix for any fax transmission. Entering the
outside line prefix you use most often is a real time saver.

You don’t need to type a W or comma (,) in the first position, because the fax
card always waits for a dial tone before dialing the first digit in a fax number.

12 Select Tone (TouchTone) or Pulse (rotary) dialing by pressing the Space bar to toggle
between the two; then press Enter.

The Test Fax Print Option screen appears.
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13 If you want to send a test fax, type the telephone number of the fax recipient and 
press Enter. 

A test page will be faxed to the number you specify. Check with the recipient
to see if the test fax was received. 

If you don’t want to test the fax software now, press Enter without specifying
a fax telephone number.

By the way:  If the test fax does not succeed, be sure that

m the receiving fax machine is working and not busy

m you supplied any required prefix, such as 9, to get an outside line on the
Telephone Settings screen

m you specified the correct printer port

m your LaserWriter 16/600 PS is turned on, on-line, and connected to an
outside line

m you correctly installed the fax card

The Windows Installation screen appears. 

14 If you plan to send faxes from Windows applications, press Enter to install the necessary
files and edit your Windows system files. 

The Confirmation of Windows Directory screen appears. Go to step 15.

If you plan to send faxes from DOS application programs only, use the arrow
keys to select the last menu item, “Skip this step without changing Windows,”
and then press Enter. Skip to step 17.
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15 Press Enter to accept the default directory, C:\WINDOWS, or type a new directory path
and press Enter.

The Install program takes a few moments to copy the files into your Windows
directory, and then displays a message stating that Windows installation is
complete.

16 Press Enter to view the Pop-up Menu for DOS Applications screen. 

17 Indicate whether you want to enable the Fax Pop-up menu for DOS applications; then
press Enter. 
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m If you will be sending faxes from DOS applications, select “Enable Fax
Pop-Up Menu for DOS Applications” and press Enter. 

The Pop-Up Menu Hot-Key Selection screen appears. Go to step 18.

m If you will not be sending faxes from DOS applications, select “Do not
enable Fax Pop-Up Menu for DOS Applications” and press Enter. Skip to
step 19.

18 Press the hot-key combination you will use to pop up the fax menu; then press Enter. 

The default is Alt–F1. If you want to use a different hot-key combination,
press the keys you want to use; do not try to edit the characters. Triple
combinations, such as Ctrl–Alt–F1, right-Shift–Alt–X, and left-Shift–Alt–7,
are acceptable.

The Automatic Loading Option screen appears.
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19 Indicate whether you want to update your AUTOEXEC file to load the fax software
automatically whenever you start your computer.

m If you installed the fax software for Windows and selected automatic
loading, the fax software loads automatically whenever you start Windows.

m If you want to modify your AUTOEXEC.BAT file so that the fax software
loads automatically, select “Update the AUTOEXEC file to load PSFAX
automatically” and press Enter. A message appears when the update is
complete.

m If you will be using a LaserWriter 16/600 PS connected to the network,
select “Skip this step without changing the AUTOEXEC file.” If you want
the software to load automatically, use a text editor to add the following
lines to your AUTOEXEC.BAT file, after the command that runs your
network’s spooler or capture utility.

c:\psfax\psfaxq

c:\psfax\psfax

m If you chose a default path other than C:\PSFAX, select “Skip this step
without changing the AUTOEXEC.BAT file.” If you want the software to
load automatically, use a text editor to add the following lines to your
AUTOEXEC.BAT file.

c:\<directory name>\psfaxq

c:\<directory name>\psfax

After you press Enter, the README File Options screen appears.



20 Press Enter to display the README file on screen, or select “Print the README file” and
press Enter. 

The README file contains important information that became available
after this guide was printed. 

21 Press Enter.

A message appears stating that the installation was successful.

22 To return to the DOS prompt, press Enter again.

23 To return to Windows from DOS, type EXIT.
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Installing the fax software on a network

The fax software can be used with a LaserWriter 16/600 PS printer connected
to a network. Be sure to follow these guidelines.

m Load the network spooler or capture utility first, then the fax software. Don’t use 
the Automatic Loading option offered in the Install program. Instead, edit
your batch file (most likely, AUTOEXEC.BAT), inserting the fax software
startup command PSFAX after the command that runs your network’s
spooler or capture utility.

m Be sure the fax software’s job-end timeout setting is less than the network’s timeout.
The job-end timeout setting—20 seconds by default—determines how
long the fax software will wait without receiving data from your software
before it decides that the job is over. 

In general, you won’t need to change the fax software’s default job-end
timeout, because most network timeout settings are longer. You should
change the job-end timeout only if some of your fax jobs are terminated
before they are completed. 

To change the timeout setting, see “Changing Timeout Settings” in 
Chapter 5. If necessary, increase your network’s timeout setting, so that 
it remains longer than the fax software’s timeout. Consult your network
administrator for instructions.

m Select the network’s capture port as your printer port when you run the Install
program. In addition, set all the applications from which you fax to print to
the printer port. Do not set your software to print directly to the network
queue.
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Installing the Fax Control Panel in Windows

If you installed the fax software for the Windows environment, the fax
software loads automatically when you start Windows. When you choose
Print from your application’s File menu, the Fax or Print dialog box appears.

If you don’t want the Fax or Print dialog box to appear, install the Fax Control
Panel icon in one of your Windows program groups. You can click the icon to
access the Fax Control Panel and turn the fax software on or off in Windows. 

To install the Fax Control Panel in Windows, follow these steps. 

1 Open the program group in which you want the Fax Control Panel icon to appear—for
example, the Windows Applications group.

2 From the Program Manager, choose New from the File menu.

3 Select the Program Item radio button in the New Program Object window and click OK.

The Program Item Properties dialog box appears.

4 Type the name you want to appear under the icon in the Description text box—for
example, “Fax Control Panel.”

5 In the Command Line text box, enter the complete path to the PSFAXCTL.EXE program
in the fax software directory—usually C:\PSFAX\PSFAXCTL.EXE—and click OK.

A Fax Control Panel icon now appears in the program group you selected.
Double-click this icon to access the Fax Control Panel. Select the Off radio
button to prevent the Fax or Print dialog box from appearing when you issue
Windows print commands. Select the On radio button to enable the Fax or
Print dialog box. 



Enabling and disabling automatic loading

During installation, you specified whether you wanted the fax software to
load automatically every time you start your computer. To enable or disable
automatic loading after installation, follow these steps.

1 From the DOS prompt, type the following line and press Enter.

\psfax\install/u

The Automatic Loading Option screen appears.

2 Select “Remove PSFAX from the AUTOEXEC file” or “Update the AUTOEXEC file to load
PSFAX automatically” and press Enter.

The Windows Installation screen appears.

3 On the Windows Installation screen, select “Skip this step without changing Windows”
and press Enter.

Setting advanced options

The Install program prompts you to select all settings that are required for fax
transmissions. You can select additional options if you wish to customize your
LaserWriter 16/600 PS fax option. 

Follow the instructions in this section if you want to do the following:

m change the number of rings before the fax answers incoming calls (the
default is two)

m assign a fax machine identification, which will appear at the top of each
page you transmit

m disable the transmission status report that is printed whenever the fax card
tries to send a fax

m set the number of times the fax software redials a number if it is busy the
first time

m set the interval between retries
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m turn on the fax speaker so you can hear dialing, ringing, and connection
sounds

m disable the activity report

m stamp the time and date on every incoming fax

m set the time or date

1 Make sure the LaserWriter 16/600 PS printer is on. 

2 At the DOS command prompt, type the following line and press Enter.

c:\psfax\install/a

Substitute the appropriate path if you installed the software in a different
directory. 

The Advanced Installation Options screen appears.

3 To print fax printer settings, select “Print fax printer settings page” and press Enter. 

Your fax printer prints a sheet showing your current settings.
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4 To change fax printer settings, select “Edit fax printer settings” and press Enter. 

The Edit Fax Printer Settings screen appears.

5 Type new values.

Number of Rings Before Answer—Type a number between 1 and 9. If you are
using a telephone on a line used for voice communication, make the number
high enough so that you have time to answer before the fax printer does.

Fax Machine ID—Type your name or your company’s name and your fax
telephone number. The software will include this information at the top of
each page in every fax. The fax machine identification is not required, but it
is helpful for the recipient.

Transmission Status Reports—By default, the fax software prints a report on the
LaserWriter 16/600 PS printer each time it tries to transmit a fax. If you do
not want reports to be printed, change this setting to Never.

Number of Retries (0–99)—Specify the number of times the fax software tries to
transmit a fax if it cannot complete the transmission on the first try.
Remember that each time the fax printer tries to complete a fax transmission,
the printer is busy and cannot print immediately.

Retry Interval (1–60 minutes)—Specify how many minutes the fax printer should
wait between retries.
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Fax Speaker—If you want to hear dialing, ringing, and the sound of the
modems connecting, select On. If you want to hear dialing and ringing, 
but not the initial connection noises, select Until Connection. To silence
modem-related sounds, select Off.

Activity Report—By default, the fax printer prints a log of recent fax activity
after about 20 transmissions. This log confirms that broadcast fax and delayed
fax transmissions were completed successfully. If you don’t want the report to
be printed, select Disable. 

Page Caption (Y/N)—Specify whether the date and time the fax was sent should
appear at the top of each page in the transmission. 

Set Fax Clock (Time/Date)—The fax printer includes its own clock, which is
supported by a long-life battery when the printer is off. You need to set the
clock only when you install the fax software or adjust the time. To set the fax
clock, type the time (hours, minutes, and seconds) and the date (month, day,
and year). Alternatively, insert your computer’s system time by pressing F2.

6 When all the settings are correct, press F10.

A dialog box appears where you can choose to save the current settings or
exit without saving.

Removing the fax software from Windows 

To remove the fax software from Windows, follow these steps.

1 Exit Windows.

2 At the DOS prompt, type the following line and press Enter.

\psfax\install/u

The Automatic Loading Option screen appears.
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3 Select “Skip this step without changing the AUTOEXEC file” and press Enter.

The Windows Installation screen appears.

4 Select “Remove the fax software from Windows” and press Enter.

5 If you installed the Fax Control Panel, delete it from Windows.

Unloading the DOS fax software from memory

You don’t need to unload the fax software from your computer’s memory.
However, you may unload it if you need to free memory.

If the fax software was not the most recently loaded memory-resident software
in your computer’s memory, remove the fax software load commands from
your AUTOEXEC.BAT file or comment them out with “REM” instructions.
Then restart (reboot) your computer.

If PSFAXQ.COM and PSFAX.COM were the last two memory-resident
programs loaded in your computer’s memory, follow these steps:

1 At the DOS prompt, type the following line and press Enter. 

\psfax\psfax/u 

2 Type the following line and press Enter. 

\psfax\psfaxq/u 

If a message states that PSFAX.COM or PSFAXQ.COM could not be
unloaded, remove the fax software load commands from your
AUTOEXEC.BAT file; then restart your computer.
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Changing installation settings

You can change settings specified during installation by running the Install
program from your hard disk—not from the original floppy disk. For
example, you might want to change the printer port; edit the “From”
information, such as sender’s name, company name, and fax number; or select
another hot-key combination for displaying the Fax Pop-up Menu.

If you want to change Windows installation settings or enable or disable
automatic loading, see “Enabling and Disabling Automatic Loading,” earlier
in this chapter.

To change installation settings, follow these steps.

1 At the DOS prompt, type the following line and press Enter.

c:\psfax\install

If you specified a directory other than the default, substitute the appropriate
path.

2 Press Enter until you see the first screen with information you want to change.

3 Make changes; then continue pressing Enter until the DOS prompt reappears.

The changes take effect the next time you start the fax software, either by
restarting your computer or issuing the PSFAX load command at the DOS
prompt.



This chapter explains how to use the fax software with IBM PC or compatible
computers. Each section explains a task and provides two sets of instructions
(for the Windows operating environment and for DOS) for these tasks: 

m Sending a fax

m Broadcasting a fax to multiple locations

m Creating and maintaining a fax phone book so you can easily select a
recipient from a list instead of typing fax numbers

m Delaying fax transmission

m Setting the transmission resolution

m Overriding outside line prefixes you entered when you ran the Install
program

m Setting up a password for incoming PostScript faxes

m Clearing a password for PostScript faxes from Windows

m Printing an activity log listing recent faxes

m Clearing the fax log in Windows

m Changing timeout settings

m Changing output ports

m Receiving faxes
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Sending a fax

This section explains how to send a fax from Windows and DOS applications.

Sending a fax from a Windows application

To send a fax from a Windows application, follow these steps.

1 Be sure that the LaserWriter 16/600 PS printer driver is selected.

See your Windows documentation for information on how to select a printer
driver. 

2 If you installed the Fax Control Panel, be sure the “Fax or Print dialog box” option is
turned on.

See “Installing the Fax Control Panel in Windows” in Chapter 4.

3 Open the file that you want to fax and choose the Print command.

By the way:  If you are faxing to a printer equipped with a PostScript fax
card—not an ordinary fax machine—it is safest to use only the standard 35
fonts that are resident in LaserWriter printers. If you use fonts that the
receiving printer doesn’t have, the receiving printer substitutes the Courier
font, changing the document’s appearance and formatting.

4 Fill out the application’s Print dialog box as you do ordinarily.

The Fax or Print dialog box appears.

As soon as you type the fax number, the Print button changes to the 
Send Fax Button.
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5 If you wish, click the Name box and type the name of the recipient. 

The name will be inserted on the fax confirmation report and cover sheet, if
you include one.

6 Type the destination fax number in the Fax Number box.

The outside line prefixes you specified during installation will be dialed
before the fax number you enter. If you have the desired name and number in
your fax phone book, you can use it. Press F2 to see it.

7 If you wish to include a cover page with your transmission, choose one (click the down
arrow).

8 If you want to include a page caption, choose one (click the down arrow).

9 Click the Fax or Send Fax button. 

If you did not include the cover page with your transmission, the software
begins transmitting.

If you did include a cover page, the Cover Page Settings dialog box appears.

10 Fill out the information you want to appear on the fax cover page.

To move to the next line in the Cover Page area, press the Tab key.



11 Click Send Fax to begin faxing your document. 

After transmission is complete, your LaserWriter 16/600 PS printer prints a
time-stamped confirmation report indicating whether the transmission
succeeded. If the transmission did not succeed, try faxing again later. (A busy
receiving unit can cause a transmission failure.)

Sending a fax from a DOS application

Follow these steps to send a fax from a DOS application.

1 Be sure the fax software is loaded.

If you selected the automatic loading option during installation, the software
loads when you turn on your system.

If you did not select the automatic loading option, type the following lines at
the DOS prompt, pressing Enter after each line.

By the way:  If you do not intend to use the fax software’s delayed or broadcast
fax features, you can omit the first line, saving approximately 10K of DOS
conventional memory.

c:\psfax\psfaxq

c:\psfax\psfax

If you installed the fax software in a directory other than C:\PSFAX,
substitute the correct directory name.

2 Open the file you want to fax.

By the way:  If you are faxing to a printer equipped with a PostScript fax
card—not an ordinary fax machine—it is safest to use only the standard 35
fonts that are resident in LaserWriter printers. If you use fonts that the
receiving printer doesn’t have, the receiving printer substitutes the Courier
font, changing the document’s appearance and formatting.

3 Be sure the LaserWriter 16/1600 Fax printer driver is selected.

Refer to your DOS application software’s documentation for information about
selecting a printer driver.
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4 Display the Fax Pop-up Menu by pressing the hot-key combination you selected during
installation.

By the way:  The Fax Pop-up Menu cannot appear when a graphics screen is
displayed unless your computer is equipped with a Hercules monochrome
graphics adapter. In addition, the Fax Pop-up Menu cannot pop up over
certain software programs that “take over” the keyboard.

5 If you wish, type the name of the recipient in the Name field. 

The name will be inserted on the fax confirmation report and the cover sheet,
if you include one.

6 Type the destination fax number, or press F2 to display the phone book and then select
the recipient’s name. 

By the way:  If you need to override the outside line prefixes you specified
when you ran the Install program, see “Overriding Outside Line Prefixes,”
later in this chapter.

Type the phone number, including the following special line prefixes, if
necessary. 

To do this Type this

Dial this number before dialing the fax number 0–9

Press this key before dialing the fax number * or #

Wait for a dial tone W

Pause for two seconds ,

For example, to dial 9 and then wait for a dial tone, type 9W. To dial 9 and
wait for a dial tone, then dial 1 and wait for a dial tone, type 9W1W. The fax
card always waits for a dial tone before dialing the first digit in a phone
number.

7 Indicate whether you want to send a cover page.

To include a cover page, select the Cover Page field from the pop-up menu.

8 Indicate whether you want a page caption.

All fields on this screen are optional.

To move to the next line in the Cover Note field, press the Tab key.
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9 Press F10.

The Fax Confirmation screen appears.

10 Confirm that the information is correct.

If it is correct, press Enter. If you need to change any of the information,
press Esc to return to the Fax Pop-up Menu; then make your changes. 

11 Within your application, issue the command you would normally use to print your
document. 

If you don’t issue a print command in your application within 120 seconds
after exiting the Fax Pop-up Menu, the LaserWriter 16/600 PS printer prints
the document instead of faxing it. This timeout is intended to prevent you
from inadvertently faxing a document you intended to print. (To change this
timeout value, see “Changing Timeout Settings,” later in this chapter.) 

After transmission is complete, your printer prints a time-stamped
confirmation report, indicating whether the transmission succeeded. If the
transmission failed, try faxing again. (A busy receiving unit can cause a
transmission failure.)

Sending a fax to multiple locations 

You can send, or “broadcast,” a fax to multiple recipients with a single
command. To do this, you must have

m added the recipients to your fax phone book. See the next section,
“Creating and Maintaining a Fax Phone Book.”

m loaded PSFAXQ.COM. It is already loaded if you installed the fax software
for Windows or if you selected the automatic loading installation option
(see step 19 in “Installing the Fax Software” in Chapter 4). If you did not
select automatic loading and are using DOS, load PSFAXQ.COM now (see
step 1 in “Sending a Fax from a DOS Application,” earlier in this chapter).

Sending a fax from a Windows application

To broadcast a fax to multiple destinations, follow these steps.

1 Chose the Print command from the Windows application.

The Fax or Print dialog box appears.
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2 Click the Phone Book button.

The Phone Book dialog box appears. 

3 Select recipients from your phone book—or click the Group button and select a group—
and then click OK.

If you selected the cover page option, the Cover Page dialog box appears. All
recipients will receive a cover page personalized with their own names and
company names.

If you did not select the cover page option, the broadcast transmission returns
to the Print or Fax dialog box showing the number of recipients you’ve faxed
to in the name and number fields. 

4 Click Send Fax.

Sending a fax from a DOS application

To broadcast a fax to multiple locations, follow these steps.

1 From the Fax Pop-up Menu, press F2 to display the Phone Book dialog box.

2 Select a recipient’s name, then “tag” it by pressing the Space bar or Control-Enter.

An angle bracket (>) appears to the left of each selected recipient. To remove
the tag, highlight the entry and press the Space bar or Control-Enter again.

If you have defined groups in your phone book and want to include them,
press F3 to access the Group Phone Book. Select one or more groups by
selecting their names one by one and pressing the Space bar or Control-Enter.
Press Enter to return to the Phone Book screen.

You can broadcast a fax to any combination of groups and individuals.

3 When you have tagged all the recipients, press F10 to return to the Fax Pop-up Menu.

The number of recipients for the broadcast fax appears in the To Name and
Fax Number fields. 

4 Send the fax as you would ordinarily.
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Viewing the recipients for a delayed broadcast

1 At the DOS prompt, type the following line and press Enter.

c:\psfax\faxmgr 

After several moments the Fax Manager menu appears.

2 Select “Display fax queue” and press Enter. 

The Fax Queue screen appears. 

The list contains scheduled jobs and jobs that could not be sent. (If the
computer or printer was turned off or the receiving fax printer was busy,
sending fails.) If no faxes are queued, you get a simple message. Press Enter.

3 Select the job on the Fax Queue screen and press Enter.

4 Select “Display broadcast fax job” and press Enter. 

The software displays a list of the selected recipients for this broadcast fax.

By the way:  To change the list of recipients for a broadcast fax, delete the job
from the fax queue and then set up the broadcast again.
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Creating and maintaining a fax phone book

To save time entering recipients’ names and fax numbers, you can create a fax
phone book that contains frequently used numbers. When you prepare to
transmit, you can select the recipients’ names from the list. The software
automatically inserts their fax numbers into the appropriate fields.

You can add individuals and groups to your fax phone book. A group is two
or more individuals to whom you want to send the same document.

Adding a phone book entry in Windows

To add a phone book entry in Windows, follow these steps.

1 From the Fax Control Panel, click the Phone Book button.

The Fax Phone Book dialog box appears.

2 Click New to display the Add a Phone Book Entry dialog box.

You can also get to the Fax Phone Book from the Fax or Print dialog box or
the Cover Page Settings dialog box.
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3 Type a name, company name, and fax number. 

To move between fields, press the Tab key or use the mouse.

Be sure to use the same format for the fax number for every entry. For
example, if you use parentheses around the area code, put them around every
area code.

Note:  If you’re faxing from your own area code, be sure to set this as one of
your options.

4 Specify the resolution for transmissions to this recipient’s fax machine by selecting a
button. 

The LaserWriter 16/600 PS Fax can transmit at two resolutions: 

m Standard (203 horizontal by 98 vertical dots per inch)

m Fine (203 horizontal by 196 vertical dots per inch)

Alternatively, if the receiving device is a printer equipped with a PostScript
fax card, you can send PostScript-language files. These print at the default
resolution of the recipient’s PostScript printer, typically 300 dpi or greater.

You can override this resolution if you want to use a different resolution for
this recipient. See “Setting the Transmission Resolution,” later in this chapter.

5 If you selected PostScript, type the recipient’s fax password (which you must get from
the recipient) in the Recipient’s Fax Password field, and click OK.

If there is no password for this printer, leave the field blank.

6 Click OK to add your new entry to the phone book.

The new entry appears as the last entry in the phone book.
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Adding a phone book entry in DOS

To add phone book entries in DOS, follow these steps.

1 From the Fax Pop-up Menu, press F2 to display the Fax Phone Book screen.

2 Press the Insert key to display the Phone Book Edit screen. 

3 Type the name, company name, and fax number of the recipient you want to add to the
phone book. 

Be sure to use the same format for the fax number for every entry. For
example, if you use parentheses around the area code, put them around every
area code.

Note:  If you’re faxing from your own area code, be sure to set this as one of
your options.

If the outside line prefixes are different from the ones you added when you
set up the software, include them before the phone number.

4 Select a resolution for transmissions to this recipient’s fax machine. 

The LaserWriter 16/600 PSf can transmit at two resolutions: 

m Standard (203 horizontal by 98 vertical dots per inch)

m Fine (203 horizontal by 196 vertical dots per inch)

Alternatively, if the receiving device is a printer equipped with a PostScript
fax card, you can send PostScript-language files. These print at the default
resolution of the recipient’s PostScript printer, typically 300 dpi or greater.

You can override this resolution if you want to use a different resolution for
this recipient. See “Setting the Transmission Resolution,” later in this chapter.

If you select PostScript, the Fax Password screen appears.

5 If the recipient’s PostScript printer requires a password, type the password in the Fax
Password screen.

Get the fax password from the recipient. If there is no password, leave this
field blank.

6 Press Enter; then press F10 to add the new entry to the phone book. 
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Adding a group to a fax phone book in Windows

A group can consist of individuals and other groups. For example, you might
create a Marketing group, an Engineering group, and a Documentation group,
and then create a group that contains all three.

To add a group to the Group Phone Book, follow these steps. 

1 In the Control Panel, click Phone Book.

2 In the Phone Book dialog box, select the entries you want to include in the group.

3 Click Save as Group. 

The Enter Group Name dialog box appears.

4 Type the name of the new group and click OK.

The group name now appears in the group phone book.

Adding a group to the fax phone book in DOS

To add a group to the phone book using DOS, follow these steps.

1 From the Fax Pop-up Menu, press F2 to view the Fax Phone Book screen. 

2 Press F3 to display the Group Phone Book screen.

3 Press the Insert key to display the Change Group Members screen.

4 Use the arrow keys to highlight an entry you want to include in the group, then press the
Space bar or Control-Enter. 

An angle bracket (>) appears beside the entry to tag it as a member of the
group. If you want to remove a member from the group, select the entry and
press the Space bar or Control-Enter again.

5 When you’ve finished tagging group members, press F10 to display the Enter Group
Name screen.

6 Type a group name and press F10. 

The group name can contain up to 32 characters, including spaces. 

The new group name appears on the Group Phone Book screen.
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Editing a phone book entry in Windows

To edit a phone book entry in Windows, follow these steps.

1 From the Phone Book dialog box, highlight the Phone Book Entry you want and 
click Edit.

2 Click Edit.

The Edit Phone Book Entry dialog box appears.

3 Type over the information you want to change.

To delete information in a field, use the Delete and Backspace keys.

4 To change the resolution, select the appropriate radio button. 

5 Click OK to record your changes in the phone book.

Deleting a phone book entry in Windows

1 Select the entry that you want to delete.

2 Click Delete. 

3 Confirm that you want to delete the entry, or click Cancel.
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Editing a phone book entry in DOS

To edit a phone book entry, follow these steps.

1 From the Fax Pop-up Menu, press F2 to display the Phone Book. If you are editing a
group, press F3 to display the Group Phone Book. 

2 Highlight the individual or group you want to edit and press F2. 

The Phone Book Edit screen appears containing the selected entry.

3 Type over the entries you want to change.

You can use the Delete and Backspace keys to delete information from the
fields.

To add or remove individuals from a group, highlight the entry, then press the
Space bar or Control-Enter to make the angle bracket appear (in the group) or
disappear (not in the group).

4 Change the resolution if desired. 

5 Press F10 to record your changes in the Phone book.

Deleting a phone book entry in DOS

Follow these steps to delete a phone book entry in DOS.

1 From the Fax Pop-up Menu, press F2 to display the Fax Phone Book. If you are deleting a
group, press F3 to view the Group Phone Book.

2 Highlight the entry that you want to delete.

3 Press the Delete key.

You are asked to verify that you want to delete this entry. Press Enter to delete
it, or press Esc to cancel deletion and return to the Fax Phone Book screen.
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Exporting fax phone books

You can exchange phone book files with others by exporting entries into an
ASCII file, with commas separating each field, in the following format:

Name,Company Name,Fax Number,Resolution,Password<carriage

return>

Follow these steps to export your fax phone book.

1 Load the Fax Manager program by typing the following line at the DOS prompt.

c:\psfax\faxmgr

The Fax Manager menu appears.

2 Highlight Import/Export Phone Book and press Enter. 

The Import/Export Phone Book screen appears.

3 Highlight Export Phone Book and press Enter.

4 Specify a filename for the file to be exported and press Enter. 

If you do not specify a path for the exported file, it will be placed in the fax
software directory.

Importing entries into your phone book

You can import phone book data in ASCII format—with fields separated by
commas—or in Intel CAS format.

If the file is not in the same directory as the fax software, specify the correct
directory. If a file named PSFAX.DIR is already present in the directory, the
imported data will be added to the end of your current phone book.

1 Load the Fax Manager program by typing the following line at the DOS prompt.

c:\psfax\faxmgr

The Fax Manager menu appears.

2 Select Import/Export Phone Book and press Enter.

The Import/Export Phone Book screen appears.

3 Select Import Phone Book and press Enter.

4 Specify a name for the file to be imported and press Enter.
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Importing and exporting a fax phone book in Windows

To import or export, follow these steps.

1 Double-click the Fax Control Panel.

2 Click the Import or Export button as appropriate.

3 Choose the Phone Book document you want to use.

Delaying fax transmission

If you don’t want to send a fax immediately, you can specify a time within the
next 24 hours when the LaserWriter 16/600 PS should begin transmission.
For example, you might want to send a fax after business hours to minimize
the cost of telephone calls, or when you are not using your printer for 
other tasks.

To send a delayed fax, your computer and LaserWriter 16/600 PS must be on
at the specified transmission time, and both PSFAXQ.COM and PSFAX.COM
must be loaded.

Delaying transmission with Windows

1 From the Fax or Print dialog box, click Options.

The Fax Options dialog box appears. 
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2 Select the “Delay until” button. 

The current system time appears in the Time field.

3 To set the time you want to send the fax, select the hour and minute fields and click the
up or down arrow to change the settings. 

4 When you have set the desired transmission time, click OK or press Enter.

The Fax or Print dialog box appears.

5 Fill out the Fax or Print dialog box as you would ordinarily. 

IMPORTANT  The computer and LaserWriter 16/600 PS must be on at the
specified transmission time, and both PSFAXQ.COM and PSFAX.COM must
be loaded. When the LaserWriter 16/600 PS transmits the fax, you cannot
print, because the printer is busy processing the fax.

To cancel a delayed transmission, see “Canceling or Rescheduling a Delayed
Fax Transmission” later in this chapter.
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Delaying transmission with DOS

To delay fax transmission, you must have loaded the memory-resident
program PSFAXQ.COM before loading PSFAX.COM. If you selected the
automatic loading installation option, PSFAXQ.COM is already loaded. If
you did not select automatic loading, see step 1 in “Sending a Fax from a
DOS Application,” earlier in this chapter.

To delay transmission, follow these steps.

1 From the Fax Pop-up Menu, press F3.

The Advanced Fax Options screen appears.

2 In the “Time to send” field, select Delay and press Enter.

The Delayed Fax screen appears.

3 Type the exact time to send the fax and press Enter. 

4 Press the arrow keys to highlight AM or PM; then press Enter.

The Delayed Fax screen appears.

5 Select the fax resolution or add any line prefixes needed for this fax recipient, and 
press F10.

The Fax Pop-up Menu reappears.

6 Supply the fax number and indicate whether you want a cover page; then press F10.

7 When asked to confirm that you want to send the fax, press Enter.

8 Print the document from your application. 

The job is placed in a print queue for transmission at the time you specified.

IMPORTANT  The computer and LaserWriter 16/600 PS must be on at the
specified transmission time, and both PSFAXQ.COM and PSFAX.COM must
be loaded. When the LaserWriter 16/600 PS transmits the fax, you cannot
print, because the printer is busy processing the fax.
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Canceling or rescheduling a delayed fax transmission

When you broadcast a fax to a group or delay transmission, the fax job is
placed in the fax queue. 

To cancel or reschedule a delayed fax transmission, follow these steps.

1 Exit Windows or execute DOS from the DOS icon in Main.

2 At the DOS prompt, type the following line and press Enter.

c:\psfax\faxmgr 

After a few moments, the Fax Manager menu appears.

3 Select “Display fax queue” and press Enter. 

The Fax Queue screen appears.

The list contains scheduled jobs and jobs that could not be sent. A job cannot
be sent if your computer or printer is turned off or when the receiving fax
printer is busy at transmission time. 

If no faxes are used, you get a simple message. Press Enter.

4 To cancel a fax job, select it and press the Delete key. 

5 To reschedule a fax job, select it and press Enter. 

If the job is a broadcast fax, a menu appears where you can choose to
reschedule or display the broadcast list. Choose Reschedule and then
continue with step 6.
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6 Select Now or Delay and then press Enter.

If you selected Delay, specify a time within 24 hours when the fax software
should try to transmit.

7 After setting the transmission time, press Enter to return to the Fax Queue screen. 

8 Press Esc to return to the Fax Manager menu.

Setting the transmission resolution 

The LaserWriter 16/600 PS can transmit at Standard or Fine resolutions or
transmit PostScript files, which print at the resolution of the receiving printer.
If you don’t specify another resolution, the software uses the resolution set up
in the fax phone book for the recipient. If you didn’t select the recipient from
the fax phone book, the software uses Fine resolution.

If you want to specify a different resolution for the next fax transmission,
follow these steps. The new resolution applies to the next fax only.

Setting the resolution in Windows

1 From the Fax or Print dialog box, click Options.

The Options dialog box appears. 

2 Select the button for the desired resolution.

3 If you selected PostScript transmission, type the recipient’s fax password, if there is one.

Get the fax password from the recipient.

The new resolution applies only to the next fax you send. 

4 Click OK or press Enter.
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Setting the resolution in DOS

1 From the Fax Pop-up Menu, press F3 to view the Advanced Fax Options screen. 

2 Select the resolution you want to use and press Enter.

If you select PostScript, the Fax Password screen appears. 

3 Type the password, if there is one, for the printer to which you are faxing; then press
Enter.

Get the fax password from the recipient. 

The new resolution applies only to the next fax you send.

Overriding outside line prefixes

When you installed the fax software, you supplied outside line prefixes
required by your telephone system (for example, 9 to get an outside line).

To change the outside line prefix for all fax jobs, run the Install program
again. See “Changing Installation Settings,” in Chapter 4. To override the line
prefixes for a single fax job, follow the instructions in this section.

Overriding outside line prefixes in Windows

1 From the Fax or Print dialog box, click Options. 

The Fax Options dialog box appears. 

If you supplied outside line prefixes when you ran the Install program, they
appear in the Outside Line Prefix field.

2 Edit the Outside Line Prefix field as needed for the next fax transmission. 

3 Click OK or press Enter when finished. 

The edited outside line prefixes apply only to the next fax job. After that, the
prefix you supplied using the Install program will apply.
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Overriding outside line prefixes in DOS

1 From the Fax Pop-up Menu screen, press F3 to access the Advanced Fax Options
screen. 

2 Type the prefix in the Outside Line Prefix field.

3 Press Enter. 

The software uses the new prefix only for the next fax transmission. Then it
resumes using the one you entered in the Install program.

Selecting a password for PostScript faxes

You can limit the PostScript faxes you receive to senders who have your
PostScript password. To set or clear a PostScript password in DOS, follow
these steps.

Setting a password for PostScript faxes from DOS

1 At the DOS prompt, type the following line and press Enter.

c:\psfax\install/a

If you installed the software in a different directory, substitute the appropriate
path. 

The Advanced Installation Options screen appears.

2 Select “Edit fax printer password” and press Enter.

The Edit PostScript Fax Password screen appears.
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3 Select “Enter a new PostScript fax password” or “Clear the fax Postscript password”
and press Enter. 

4 Type the new password and press Enter. 

5 Press Y to confirm that you want to change the password.

Setting a password for PostScript faxes from Windows

To set a password for PostScript faxes from Windows, follow these steps.

1 Locate the Fax Control Panel icon. 

2 Double-click the Fax Control Panel.

The Fax Control Panel appears.

3 Click Password.

The Set Password dialog box appears.

4 Type the password into the New Password box.

5 Type the same password into the Confirm Password box, keeping the same case for
each character.

If the two passwords match, the OK button changes from grayed characters
(inactive) to dark characters (active). If the OK button is inactive, delete and
retype the Confirm Password. If the OK button remains inactive after a
couple of tries, click Cancel and try again. You probably mistyped the
password.

6 Click OK.

The Set Password dialog box appears with the message “Printer 
password set.”
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Clearing a password for PostScript faxes from Windows

To clear a password for PostScript faxes from Windows, follow these steps.

1 Locate the Fax Control Panel icon (many people put this in the Applications folder).

2 Double-click the Fax Control Panel.

The Fax Control Panel appears.

3 Click Password.

The Set Password dialog box appears.

4 Click OK.

A message asks, “Clear PostScript Fax Password?”

5 Click OK.

The Clear Password dialog box appears with the message “Printer password
cleared.”

Printing a fax activity log

An activity log lists recent faxes sent by your fax printer.

Printing a fax activity log from DOS

To print an activity log from DOS, follow these steps.

1 Type the following line from the DOS prompt and press Enter.

c:\psfax\faxmgr 

The main menu for the Fax Manager software appears.

2 Select “Print Fax Activity Report” and press Enter.

3 Press Esc or select Exit; then press Enter.
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Printing a fax activity log from Windows

To print an activity log from Windows, follow these steps.

1 Locate the Fax Control Panel icon.

2 Double-click the Fax Control Panel.

The Fax Control Panel appears.

3 Click “Print Fax Log.”

The Print Fax Log dialog box appears. If all goes well, you get the message
“Activity log printed.”

Clearing the fax log in Windows

In Windows, you can clear the print log. Follow these steps.

1 Locate the Fax Control Panel icon. 

2 Double-click the Fax Control Panel.

The Fax Control Panel appears.

3 Click “Clear Fax Log.”

The Clear Activity Log dialog box appears with the message “Activity log
cleared.”
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Changing timeout settings

The fax software has two timeout settings: 

m The job-start timeout controls how long the LaserWriter 16/600 PS waits
between the time you pop up the Fax Pop-up Menu and the time you send
the fax. The default is 120 seconds.

m The job-end timeout controls how long the LaserWriter 16/600 PS waits
after input stops during the course of a job. The default is 20 seconds.

If the faxes that you send are terminated before they are complete, make
the job-end timeout longer. Transmission is sometimes terminated when
you are faxing from an application that pauses to process more data during
printing, as a graphics or database application may.

Changing the job-start timeout from DOS

1 At the DOS prompt, type the following line and press Enter.

c:\psfax\install/a

If you installed the software in a different directory, substitute the appropriate
path.

The Advanced Installation Options screen appears.

2 Select “Edit timeout settings” and press Enter. 

The Edit Timeout Settings screen appears.
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3 In the “Fax Job Start Timeout” field type the number of seconds (0 to 999) that you want
for the timeout and press F10. 

4 Press F10 to exit. 

5 Select “Save advanced fax/printer options” to exit to DOS.

6 Press Enter to confirm the change you’ve made.

Changing the job-end timeout

IMPORTANT  If your LaserWriter 16/600 PS printer is connected to the
network, your job-end timeout setting must be less than your network’s
timeout setting.

To change the fax job-end timeout, follow these steps.

1 At the DOS prompt, type the following line and press Enter.

c:\psfax\install/a

Substitute the appropriate path if you installed the software in a different
directory. 

The Advanced Installation Options screen appears.

2 Select “Edit timeout settings” and press Enter. 

The Edit Timeout Settings screen appears.

3 In the “Fax Job End Timeout” field, type the number of seconds (0 to 999) that you want
for the timeout and press Enter. 

4 Press F10 to exit. 

5 Press Enter to confirm the change you’ve made.
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Changing output ports after installation

Typically, the fax captures its output from the port you designated as the
printer port. You can change that port in either DOS or Windows.

Redirecting printer port output from DOS

1 At the DOS command prompt, type the following line and press Enter.

c:\psfax\install/a

If you installed the software in a different directory, substitute the appropriate
path. 

The Advanced Installation Options screen appears.

2 Select “Edit printer port redirection” and press Enter.

The Printer Port Redirection screen appears.

3 Select the port from which you want the fax software to capture (redirect) data and 
press Enter.

Changing the fax port from Windows

1 Locate the Fax Control Panel icon.

2 Double-click the Fax Control Panel.

The Fax Control Panel appears.

3 Click “Select Fax Port.”

The Select Fax Port dialog box appears.

4 Scroll through the list of ports and select one.

5 Click OK or press Enter.
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Receiving faxes

To receive a fax, you need to have the printer turned on. The computer can be
off. A properly configured printer will print each fax when it comes to the top
of the print queue.

To print large documents, such as legal-size faxes, put legal-size paper in 
a paper tray and install it. The fax option will print on what it finds there. 
If a legal-size fax is received and no legal-size paper has been loaded into the
printer, each page of the fax will be reduced in size to fit on letter-size paper.
Fax pages will also be reduced in size if a letter-size fax is received that does
not have adequate top and bottom margins.
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This chapter provides solutions to problems you may encounter when you
install and use the fax software. It also lists error messages that may appear on
IBM PC or compatible computers when you are loading or unloading the fax
software.
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Troubleshooting on Macintosh computers

The printer isn’t working.

Check the following:

m The LaserWriter 16/600 PS is turned on.

m The LaserWriter 16/600 PS is connected to your computer.

m The LaserWriter 16/600 PS is selected in the Chooser.

m The LaserWriter 16/600 PS printer software (not fax software) was
installed, as described in the user’s guide that came with the printer.

If none of the above is responsible for the problem, reinstall the fax software
as described in Chapter 2.

The printer prints or transmits an incomplete document.

Try the following remedies.

m Make more memory available by closing application programs and
windows. You may want to buy more memory for your computer.

m If you are sending to a Group III fax machine—and not to a printer
equipped with PostScript fax capability—select the Unlimited
Downloadable Fonts option in the Page Setup dialog box. This helps you
manage memory without significantly affecting performance.

m If an alert message indicates the printer has a memory problem, continue
printing. If the resulting output is unsatisfactory, reduce the number of
fonts in the file and print again, or fax just a few pages at a time.

m If none of the above remedies works, there might be a PostScript-language
error in the document. Click the Options button in the program’s Print
dialog box. Then choose Print Detailed Report from the PostScript Errors
pop-up menu. If a PostScript error occurs, the LaserWriter 16/600 PS fax
printer prints an error page.
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Fax documents are not successfully transmitted.

If the confirmation page indicates that the transmission was not successful, try
the following steps.

m Refer to the confirmation page to verify that the software dialed the correct
number. Check the outside line prefix, long distance prefix, and area code. 

m Be sure to use the same format for the area code in the Fax Options dialog
box and the fax phone book. For example, if you enclose the area code in
parentheses in the Fax Options dialog box, you must also use parentheses
in the fax phone book. 

m Turn on the fax speaker, so that you can hear if the receiving fax device is
busy or if there is a recorded message. To turn on the fax speaker, open the
LaserWriter Fax Utility program, choose Incoming Settings from the
Configuration menu, and click the Speaker On button.

The Fax button does not appear—or is dimmed—in the Destination section of the Print
dialog box.

The fax software is not installed properly. In the Chooser, be sure the
LaserWriter 8f icon is selected, then double-click the name of the desired
printer.

By the way:  Certain programs, such as Aldus PageMaker (version 4.2 and
earlier) and QuarkXPress, use a printer driver other than Apple’s. If you don’t
see the Fax button, click Cancel, and then choose Print again while holding
down the Option key. If the Fax button still does not appear, refer to your
program’s user manual for instructions on using the LaserWriter 8 driver.

If the Fax button still does not appear, reinstall the fax software as described
in Chapter 2.
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The recipient informs you that the PostScript document you sent contains the Courier
font instead of the original font.

If the PostScript-language document you are faxing contains fonts that aren’t
installed in the sender’s or the recipient’s PostScript printer, the receiving fax
printer substitutes the Courier font. To correct the problem, try the following
remedies.

m Reformat your document with the 35 fonts resident on most PostScript
printers.

m Ask the fax recipient to install the necessary fonts.

A PostScript fax you receive contains the Courier font instead of the correct fonts.

The sender faxed you a document containing fonts that were installed on the
sender’s printer, but not on your printer.

m Ask the sender to reformat the document with the 35 fonts resident on
most PostScript printers, or with a font you know is installed on your
printer.

m Ask the sender to provide the font, or install the font yourself on your
printer.

Opening the Fax Phone Book takes a long time.

Having more than 100 entries in the phone book creates performance
problems. If you have more addresses, consider creating multiple books, each
with its own title. For example, you could have a Personal Fax Book, Vendor
Fax Book, and Clients A–G Fax Book. When you want to use one of them,
rename the current Fax Phone Book with another name. Then rename the
phone book you want to use with the name “Fax Phone Book.”

There are also limits to the length of each item in a line—Name, Company,
Fax Number, PostScript (Y/N)? are 50, 50, 100, and 1 ASCII characters,
respectively. Separate items with a tab character and separate the PostScript
(Y/N)? from the carriage return character with a tab. You can leave a field
blank, but put a tab separator on each side.

Further, make sure all characters are from the lower (7-bit) ASCII character
set (those you get by pressing any character key with or without the Shift
key). Convert higher character-set characters like curly quotes to 
7-bit characters.
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When trying to send a fax to someone with a voice/fax/data switch, the printer doesn’t
send the fax. Is there a way to force the printer to send?

There is no way to force the printer to send a document. Contact the maker of
the voice/fax/data switch for help. Some such switches are configurable.

I see a message about a memory problem.

The fax you sent is bigger than the printer’s memory capacity. The printer
returns an error message concerning a memory problem.

Follow these steps:

1 Reduce the number of fonts in the document.

2 If memory remains a problem, break the document into pieces and fax each piece
separately.

Fax software error messages in DOS

Errors in loading or unloading fax software components cause the error
messages in this section.

Loading the PSFAX.COM program

PSFAX cannot load, because the printer port does not

exist.

When you ran the Install program, you specified a printer port that doesn’t
exist on your system.
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Unloading the PSFAX.COM program

Beginning to unload PSFAX... 

PSFAX is not currently loaded.

You have tried to unload PSFAX.COM, but it was not loaded.

PSFAX is not the most recently installed memory resident

program. Unload the most recently installed utility first. 

You can unload PSFAX.COM using the PSFAX/U command only if
PSFAX.COM was the last memory-resident program loaded. If not, try
unloading more recently loaded programs (consult their manuals for
information on unloading). Then try issuing the PSFAX /U command again.
If you cannot unload more recently loaded programs, use a text editor to
remove PSFAX from your AUTOEXEC.BAT file or to comment it out with
the “REM” instruction. Then, restart (reboot) the computer.

PSFAX encountered an error releasing its memory segment

while unloading. 

To unload PSFAX.COM you must restart.

PSFAX is unloaded.

Unrecognized command: 

The PSFAX command line switches are:

/b use BIOS level data capture only

/e release environment space when loading PSFAX

/h show this help screen

/u unload the resident PSFAX

/k enable fix for keyboard Ctrl-Lock 

The message indicates you tried to use a command-line switch that
PSFAX.COM doesn’t recognize. Only the above switches are recognized.
Substitute the appropriate switch.

There is an error in the configuration file PSFAX.CFG at

the XXX line. 

The configuration (.CFG) file that the Install program created contains an
error. Run the Install program again from the floppy disk to create a new
.CFG file. 
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Loading the PSFAXQ.COM program

Fax Queue cannot load, because the printer port does not

exist. 

The printer port you specified when you ran the Install program doesn’t exist
on your system.

Fax Queue isn’t the most recently installed memory-resident program. Unload
the most recently installed utility first. 

You can unload PSFAXQ.COM using the PSFAX/U command only if
PSFAXQ.COM was the last memory-resident program loaded. If not, try
unloading more recently loaded programs (consult their manuals for
information on unloading). Then try issuing the PSFAX /U command again.
If you cannot unload more recently loaded programs, use a text editor to
remove PSFAXQ from your AUTOEXEC.BAT file or to comment it out with
the “REM” instruction. Then restart (reboot) the computer.

Fax Queue encountered an error releasing its memory

segment while unloading.

Remove PSFAXQ from your AUTOEXEC.BAT file or to comment it out with
the “REM” instruction. Then restart the computer.

Fax Queue is unloaded. 

Unrecognized command: 

The Fax Queue command line switches are:

/e release environment space when loading Fax Queue

/h show this help screen

/u unload the resident Fax Queue 

You tried to use a command-line switch that PSFAXQ.COM does not
recognize. Only the above switches are recognized. Substitute the appropriate
switch.
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turning on or off
DOS/Windows  62
Macintosh  16

fax software, DOS/Windows
automatic loading  55
changing settings  64
installing  48–56
removing from Windows  62–63
unloading from memory  63

fax software, Macintosh
changing settings  14–15
installing  12–13
selecting incoming fax options  15–16
setting time and date  17
verifying installed files  13

fax speaker, turning on or off,
DOS/Windows  62

fax status, updating, Macintosh  43
fax transmission, DOS

affecting printing  82
to a PostScript printer  75
delaying  82
viewing recipients for a delayed

broadcast  72

fax transmission, DOS/Windows,
canceling or rescheduling
83–84

fax transmission, Macintosh
options  20–25
of a PostScript fax  25
troubleshooting  97

fax transmission, Windows
delaying  80–81
canceling or rescheduling  83–84

fax transmission status reports,
DOS/Windows  61

Fine resolution, LaserWriter 
16/600 PS  84

folders, Macintosh
Extensions  13
LaserWriter Fax Software  

13, 15, 17, 23, 40–41
LaserWriter Fax Tools  23
Printer Descriptions  13
System  13, 23, 41

fonts
sent to a PostScript printer

DOS  68
Macintosh  25
Windows  66

troubleshooting, Macintosh  98

G

grounding the printer  6–7
grounding wrist strap, attaching to printer

2, 5, 7
Group III printers, sending a fax to,

Macintosh  36
groups

adding to fax phone book entries
DOS  76
Macintosh  30
Windows  76
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H

Hard Disk Drive Selection screen,
DOS/Windows  49

hardware requirements  2
hot key, for fax software, DOS/Windows

48, 54

I

IBM PC or compatible computer,
hardware requirements  2

icons
Fax Control Panel, Windows  58
Installer  12

identification of fax machine
DOS/Windows  61
Macintosh  16

importing fax phone book entries
DOS  79
Macintosh  31
Windows  80

incoming fax options, Macintosh  15–16
incomplete documents, 

troubleshooting  96
Installer icon  12
Installer program, Macintosh  12
installing fax software, DOS/Windows

for automatic loading  55
changing DOS hot-key 

combinations  48
changing settings  64
copying the fax software files  49
for DOS applications only  52, 53–54
installing Fax Control Panel in

Windows  58
on a network  57
on a network printer  50

README file  56
removing from Windows  62–63
selecting a printer port  48–50
selecting the hard disk drive 

directory  49
sending a test fax  52
setting advanced options  59–62
setting dialing options  51
setting fax sender information  50
updating the AUTOEXEC.BAT 

file  55
for Windows applications  

52, 53, 55, 58
installing fax software, Macintosh

installing the LaserWriter 8f printer
14–15

LaserWriter 8f printer driver  12
LaserWriter Fax Utility program  12
selecting incoming fax settings  15–16
setting the date and time  17
verifying file locations  13

installing the fax card
closing the printer  8
connecting the printer to a phone line

9–10
equipment required  2
opening the printer  3–5
seating the card  6

J, K

jack, phone  2, 9
job-start/job-end timeout, changing,

DOS/Windows  90–91
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L

LaserWriter 8f printer driver, installing
12–13

LaserWriter 16/600 PS Fax printer
description file  13

LaserWriter Fax Log program. 
See Fax Log program

LaserWriter Fax Software Folder,
Macintosh  
13, 15, 17, 23, 40, 41

LaserWriter Fax Tools folder, 
Macintosh  23

LaserWriter Fax Utility, Macintosh  
13, 17, 40

LaserWriter Print dialog box, Macintosh
26, 33, 37

LaserWriter 8f icon  14
legal-sized faxes

DOS/Windows  93
Macintosh  45

M

Macintosh computer
copying log entries to an 

application  44
creating a fax phone book  26–33
hardware requirements  2
installing fax software  12–13
printing fax activity reports  40
receiving a fax  45
selecting time and date for fax

software  17
selecting transmission options  20–25
sending a fax  33–40

sending a fax to multiple 
destinations  15

setting incoming fax options  15–16
setting up fax software  14–15
troubleshooting  96–99
using the LaserWriter Fax Log

program  41–45
Macintosh disks, required  2
Macintosh Fax Printer disks  2, 12
maximum number of retries, 

Macintosh  22
memory

requirements  2, 48
unloading DOS software from  63

memory tips  96

N

naming the printer, Macintosh  14
networks, installing fax software on,

DOS/Windows  57
number of rings before answering,

Macintosh  15–16

O

opening the fax printer  3–5
outside line prefixes

overriding
DOS  86
Macintosh  21
Windows  85

setting
DOS/Windows  51
Macintosh  21
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P, Q

page caption
DOS  69
DOS/Windows  63
on fax cover page

DOS  67
Macintosh  23
Windows  69

Windows  67
password

DOS  86–87
Macintosh  16, 29
Windows  87

phone book. See fax phone book
phone jack  2, 9
phone line, connecting the fax printer to

9–10
phone line connector  6
Pop-up Menu for DOS Applications

screen, DOS  53
Pop-Up Menu Hot-Key Selection screen,

DOS/Windows  54
ports. See printer ports
PostScript fax

advantages  x
selecting a password for

DOS  86
Macintosh  16

PostScript files, installed location,
Macintosh  13

PostScript format, sending to, 
Macintosh  36

PostScript printer
DOS/Windows  66, 75
resolution for receiving faxes,

Windows  74
PostScript Printer Description (PPD) file,

installed location  13
prefixes

overriding
DOS  69, 85
Macintosh  38

Windows  67, 85
setting

DOS/Windows  51
Macintosh  21

printer. See fax printer
printer circuit board, attaching fax

connector to  7
printer covers

removing  3–4
replacing  8

printer description file, LaserWriter
16/1600 PS  13

Printer Descriptions folder  13
printer drivers

Macintosh, LaserWriter 8f  12, 26
other than Apple  26, 33, 37

printer icon  9
printer ports, redirecting output, DOS  92
Printer Port Selection screen  49
printing, DOS/Windows

fax activity log  88–89
legal-sized faxes  93

printing, Macintosh
activity reports  16, 40
Background Printing  15
a confirmation page  24
a copy of a fax  15
legal-sized faxes  45
troubleshooting  96

printing startup page  9
PrintMonitor, in Application menu,

Macintosh  39
Program Item Properties dialog box,

Windows  58
PSFAX.COM program, DOS

troubleshooting  99–100
PSFAX DOS directory  49
PSFAXQ.COM program, DOS  82

troubleshooting  101
pulse dialing  21
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R

README file  54–55
receiving a fax

DOS/Windows  93
Macintosh  45

resolution
DOS  85
Macintosh  24
Windows  84

retries
number of

DOS/Windows  61
Macintosh  22

rings before answering
setting number of

DOS/Windows  61
Macintosh  15–16

rotary dialing  51

S

screens, DOS
Edit PostScript Fax Password  86
Pop-up Menu for DOS 

Applications  53
screens, DOS/Windows

Advanced Installation Options  60
Automatic Loading Option  54
Edit Fax Printer Settings  61
Edit Timeout Settings  90
Hard Disk Selection  49
Pop-Up Menu Hot-Key Selections  54
Telephone Settings  50
Test Fax Print Option  51
User’s Fax Sender Information  50

screens, Windows, Confirmation of
Windows Directory  53

selecting a password for, 
PostScript fax  16

sender information
DOS/Windows  50–51
Macintosh  14–15

sending a fax, DOS  71
to a PostScript fax card  68, 86–87
delaying transmissions  82
entering recipient information  69
including a page caption  69
to multiple locations  71
overriding outside line prefixes  86
selecting a printer driver  68
setting a PostScript password  86–87
setting resolution  84
specifying a cover page  69

sending a fax, Macintosh
to a single destination  33–35
confirmation page  24
delaying transmission  38–40
dialing options  21–22
to multiple destinations  15, 36–38
overriding outside line prefixes  38
PostScript  25, 36
and printing a copy of the fax  24
to recipients with different formats  36
resolution  24
specifying a cover page  22–23
troubleshooting  97

sending a fax, Windows
to a PostScript printer  66, 88
delaying transmission  80–81
including a cover page  67
including a page caption  67
to multiple locations  70–71
overriding outside line prefixes  85
recipient information  66–67
setting and clearing a PostScript

password  87
setting resolution  83

software requirements  2
speaker. See fax printer speaker
Standard resolution, LaserWriter 

16/600 PS  84
startup page, printing  9
static electricity, preventing harmful

discharge  5
System Folder, Macintosh  13
system software requirements  2
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T

telephone cable, connecting to printer  9
telephone companies, and modem use  vi
telephone cord  2
Telephone Settings screen,

DOS/Windows  50
television and radio interference  v
Test Fax Print Option screen,

DOS/Windows  51
time and date

DOS/Windows  62
Macintosh  17

timeout settings, DOS/Windows  90–91
timeout value, DOS  70
tone dialing, Macintosh  21
TouchTone dialing, DOS/Windows  51
transmission. See sending a fax
transmission options. 

See fax transmission options
troubleshooting

DOS  99–101
Macintosh  96–99

U

unloading fax software, 
DOS/WIndows  63

User’s Fax Sender Information screen  50

V

viewing recipients of a delayed
broadcast, DOS  72

W, X, Y, Z

Windows and DOS Fax Printer disk  
2, 48

Windows applications
adding a group to a phone book  76
adding an individual to a phone book

73–74
canceling or rescheduling a delayed

fax transmission  83–84
clearing the fax log  89
creating Fax Control Panel icon  58
delaying transmission  80–81
disks required  2
editing phone book entries  77
exchanging phone books  80
installing fax files  52, 53
overriding outside line prefixes  84
printing a fax activity log  89
redirecting the fax port  92
sending a fax to multiple locations

70–71
sending a fax to one location  66–68
setting a password for PostScript faxes

87–88
wrist strap, grounding  2, 5
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